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Chapter 1. Getting Started

Welcome

Welcome to the Pulsonix electronic design system. The system is built on an integrated design
environment providing all the tools required to capture a schematic and simulate it using the Spice
based A/D mixed mode simulator, through to the design and layout of the printed circuit board (PCB)
which is aided with a powerful shape-based auto router.

Pulsonix appedls to all users, from the casual to the full time user because of its simplicity and
straightforward approach. Pulsonix is structured in such away that its menu structure and options
naturally leads you through the design sequence, that in turn means you don't 'jump’ about within the
product hunting for functionality.

About this Manual

The contents of this manual

Like all aspects of Pulsonix, the Users Guide has been written to be as usable as possible with the
least amount of effort. It has been produced in a manner that will get you started in the quickest time
possible by describing functionality based on the logical steps of apractica design cycle. Even if

your design cycle doesn't follow the exact path in this manual you can get your questions answered by
turning to the relevant sections. The manual does not take you through every detail but will guide you
through the essentials to produce adesign. The on-line help provides further information in context
about each option. It is directed at users who understand the fundamentals of designing PCBSs; it is not
intended as acourse in designing PCBs.

Where to find additional information

Additional information and help located in the accompanying HTML on-line help system. Once the
Pulsonix product has been installed and is running, you can cal help at any time by locating the Help
index from the Help menu and selecting one of the options available.

System Requirements

Hardware required

To run Pulsonix your PC hardware will need to conform to the following requirements:

® A Pentium class processor (i5 or i7 performance or better recommended)

e Microsoft Windows 10 recommended *

e At least 4-8Gb of RAM

e Graphics to support DirectX 10

e 1.4Gb of hard disk space for the al files supplied, including libraries and run timefiles

e 3 button mouse with wheel is recommended although any mouse will work

* |t is highly recommended that the most up-to-date Windows operating systems are always used.
Please check our web site for the Pulsonix operating system support policy.
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Program security

The Pulsonix design system is protected by asecurity key or network address, plus an accompanying
license code. The key is attached to the USB port for a node-locked system; you may also use a
Network Address to replace the security key. If using this protection, a key would not have been
supplied. For ‘floating’ network license systems the license resides on aserver system, this will also
be paired with a MAC address or USB key.

If updating or upgrading your program from an earlier version you may require anew license. You
will be supplied anew license if needed and you will be informed of the procedure to useit.

Installation

For new users (normal installation)

To install any of the Pulsonix products, as a standard precaution we recommend that you first close dl
other applications, saving your work if necessary.

This procedure is used for any ‘client’ installation, that is, an installation which is not using a network
license scheme and for which the dongle resides on the same machine. For floating network licensing
refer to the Network Licensing Ingtallation Guide.

USB Key Driver

You must NOT connect the USB key (dongle) before installation is attempted. Once Pulsonix has
been installed you will need to connect it. The Setup program will install a special HASP USB Key
driver to use. Once Pulsonix is installed and the USB key attached, Windows will automatically
detect the key and will use the new supplied driver. You cannot use the standard Windows Plug &
Play driver.

Licensing

Normally, the license file will be supplied to you by email with the name licensellicor

key _number.lic This license file includes any products and cost options purchased. Creste a suitable
folder and save it into this on your hard drive. During installation you will be asked to browseto it.
You can use this location if changing from a Trial system to the licensed product once purchased.
You can dso use the License Manager to browse to the location of the licensefile if switching
between thetrial system and an evaluation license.

MAC Address License

A license may also be supplied to you that is locked to your computer’s MAC address. This is an
alternative to using a USB key security mechanism. The procedure for installation will be exactly the
same as with the USB key detailed above.

Installation from a download

If you have been provided with adownload link to install Pulsonix from the Pulsonix web site, click
on the link provided. This download a packed executable file which will run once setup has been
double clicked. The setup pages will direct you through the install. Follow the instructions provided.

Installation from the CD

Insert the CD-ROM into the CD drive and wait for a short time. The default setup will start the Setup
program. If your system has the autorun facility disabled, or it simply hasn't worked, select Run from
the Start menu, and type D:\intro.exe (replacing the D: with the actual CD drive letter if yours is
different), then press <Enter>.
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Setup Screen
If running from a CD-ROM, from the Setup page, select Pulsonix Application from the menu.

3 Pulsonix Version Setup — X
PULSONIX Welcome to Pulsonix
N Pulsoni - the fully integrated Schematic and PCB suite.

Choose a product to begin installation, or a document to view. If prompted, click the Run or
Open command for any dewnload or security waming dialog that appears.

Please allow Setup to finish completely before beginning another product installation.

Pulsonix
Desktop Application Pulsonix Application L!;'i‘
Install the desktop (client L =
application for fully
integrated circuit design
d board layout Pulsonix Update Notes
Network License Server
Network License Guide
Vault Database Server
Browse: Datasheets - Documents - Testimonials - CD Visit the Pulsonix site to learn more >

The Pulsonix Setup Wizard will guide you through installation of the software. Follow the steps
displayed on-screen and press the <Next> or <Back> buttons to move through each stage. If you need
to, you can abandon the installation at any time by clicking on the Cancel button -and then Exit.

The setup procedure is fully described in the Startup Notes booklet supplied or available on the
installation CD under \Documents.

If you have installed Pulsonix from an electronic download, al the users guides and additional
information supplied on the CD is available from the Pulsonix.com web site.

Moving the Installation

If you wish to move Pulsonix from one machine to another, you cannot simply copy the installation,
you must use the installation CD or download executable file to re-install it. The Setup program must
be used in order to install the required registry entries.

Updating Pulsonix from the web

Pulsonix can be automatically updated through our web site with the latest fixes that become
available from our development centre. This facility is available for al users with a current
maintenance contract and alogin account.

To check and access the latest patches from the web site, from within Pulsonix, go to the Help menu
and select Check For Updates... When sdlected, adialog is displayed, this alows you to set up when
you want to check for updates and where to check. It aso alows you to force acheck now. This will
automatically direct you to the Pulsonix Updates page from where you can login and download the
latest patch available.
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Check For Updates X

When To Chedk

(_) Once a day as I start the program
(") Every time I start the program Cancel
(®) Don't check automatically, only from this dialog

Where To Check

| http:/fwww.pulsonix, com

Use Default
Recent
Mot checked

Check For Updates Now...

If apatch isn’t available, the dialog will report that none are available at this time. Before installing a
new patch, ensure that Pulsonix isn’t running, if it is, it must be closed.

You can dso save the executable file to your local disk if you wish to install it a a later time or on
another machine or over a local intranet network onto several machines.

Floating Network Licensing

Floating network licensing is the ability to run any number of licenses from one centra server without
the need for a dongle on each machine to run the product. This type of licensing effectively floats on
the network until booked out by Pulsonix and used. Pulsonix supports this as a cost option to the
regular product.

For instdlation instructions, an installation guide is supplied on the product CD or from the download
page of our web site. Please refer to the Network License Installation notes for further information.
These are also available as a PDF file on the installation CD supplied.

Uninstalling Pulsonix

To uninstall the product from your hard drive you should use the Remove option from the Setup
program. For product updates or upgrades you do not need to uninstall existing product first
regardless of its version.

Contacting Technical Support Resources

Access to our support engineers is available via the internet, e-mail and telephone (Monday to Friday
10:00am to 5:00pm in the UK). Outside this location please contact your loca support centre.

Email: support@pulsonix.com
Phone: +44 (0)1684 296 570

Support is limited to: Installation assistance and questions regarding Pulsonix usage, design,
manufacturing and library design, all answered in context of how to use the features. Consultancy is
also available, for more information about this service, please contact our international sales office.
After your free support has expired, extended support options can be purchased from our sales office.

Whenever our technical desk is contacted, you will need to have your contact details (phone and
email address) available, plus the product version number. It helps us and speeds up the process if any
problems can be reproduced on our demo designs supplied.

Please note that we can only support the current major version, especialy when attempting to
reproduce problems.
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Chapter 2. Using Pulsonix

Introduction to Pulsonix

Starting Pulsonix

The start location of the program can be set using the Folder s option on the Setup menu. Please refer
to the Setting up The Design Chapter, Using Folders and Files.

The Pulsonix Desktop

When you run Pulsonix, the main application window appears. Pulsonix operates a multiple
document interface (MDI), so you can open any number and combination of different Pulsonix
designs types, aswell as libraries and additional tools.

Docked Auto-hide
Menu toolbar Menu Sub-menu toolbar World-view dockable
windows
[
=] Pu\sunix‘-\[PCB Design: PC3-UDIMM_ROUTED] = u] X
File Edit | View| Insert Setup Utiities Simubtion [Tools OQutput Window Help - 8%
D@ (g  Colourkie KeRE QIRAQ, (HhE THES a6, l
Conpuneatisy E + | Component Bin LR
ke Database Bar g
= Design Browser D World View x EEEE . =
H
a3 DRC Errors Bar NI EEER
== = 5
T Find Bar Ctri+F o — W ,E] O B
& Layers Bar Cri=L jpumy SR E
o Select Mask Bar o i “—8 - ‘é
O [& inspector Bar i i | e @
> @ rougie ares Ll ]l
A 2. BEfa Connectors: H
Part Browser Ctrl+B = 5 LB 80 -- CONNL [6] - DINd1612-PLG-64 |
&l Rule Spreadsheet Bar H 3 E‘"i
& L Shape Information Bar ] o P::ll &
=
=, World View w FT FF Pin12 o
Pin13 2
E View = 2 L —— Pin€3 E
i o
Al Mark View M Qo setvie g
& Power Plane M| B swap View Shift+5
3D View . GoToView ol
= e
[, T L
" T r
FEEERZES
« [ o e »

& Hish
€L Databas

peed design | il RoutingDero7 | | RoutngDemol ., [Bilinter:Progessing *

Store current viey

Grid: <Waorking= 25.00) Abs|10506.77+|12055.00+| thou

Workbook Status bar

'mode’

Design window Component bin

(maximised)

Floating toolbar

Pulsonix Menu Options

The Menu bar contains options relevant to each application open within Pulsonix. The menus are set
out logically to be used as you move through the design cycle starting from the left and moving right.
This methodology is only applicable if you are following this basic principle. The basic principle still
applies regardless of where you start in your design cycle. The menus are logical and intuitive to
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understand. The menu bar is similar to atoolbar in that it can be 'docked' in place or left 'floating' on
the screen as you wish.

Using Multiple Screens
Pulsonix can be used with more than one screen to provide you with Schematics on one and PCB on

the other, for example. By default, Pulsonix is setup to use just the one screen but can be easily
switched to use two.

P To enable multiple screen usage
1. If you wish to use more than one screen, from the T ools menu, select Options.

2. Fromthe M ulti-Screen tab, select the Enable M ulti-Screen Support check box.

B Options - Multi-5Screen

Design Backups Enable Mutti-Screen Support
Displ
|st 2y Windows for each type of design file
Edit Shape
Edit Track Window for SCM and PCE designs Window for other file types
File Extensions < swap = @ ) Ary Window
Find (O Window #1
Wi , Wi J
General Window#1 Window#2 @ Window £2
In-Place Mames
Interaction Other Settings
Macros Open all windows on application startup
Move Exit in one window means Exit in all
g Multi-Screen
Online DRC System Information:

Resohve Net N
esolve ames System has one monitor

Select

Synchronisation Generic PnP Monitor

Tooltins AMD Radeon HD 7000 series
P 1920 1080 32bit 60 Hz

Track Length Limits

Warnings Default Manitor

AMD Radeon HD 7000 series
Appears to have no display attached
Defautt Monitor

AMD Radeon HD 7000 series
Appears to have no display attached

3. With this enabled, two instances of the application will work together to arrange your files so you
can easily work on Schematic designs on one screen, and PCB designs on the other. Each
instance will have its own menus and toolbars and work independently, but will share
information when they need to.

4. Options on this page allow you to organise which screen is used for each program type.
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The Status Bar

The status bar appears across the bottom of the Pulsonix framework. The bar contains two sets of
information; the Prompt / M essage box displays useful information about the current activity and
also provides basic instruction to its use. If an option doesn't behave as expected this area should be
checked first to see what the system is expecting you to do, aprompt message is displayed in this
area.

|Select item(z). Use Shift+Click’  [Board [Style: Board [width: 12.00 [Layer: <Through Boards [&bs [22375.00 [22050.00 [thou é|

| | | I L

FPrompt f Message Froperties Co-ordinates  Units

The Prompt/Message box is asingle instruction box, the box to the right of this contains display
Property information about any design items selected. The information in these boxes is not
exhaustive but does contain commonly required information about the item selected. For more
detailed information about any selected item, right click and click the Properties command from the
context menu.

The status bar displays Co-ordinate information about the position of the cursor within the design as
an X and Y co-ordinate value. These co-ordinates are shown as either absolute [Abs] or relative
[Rel] depending on the mode selected. The current design Units are also shown on the status bar.

When viewing the X,Y co-ordinates on the status bar you will notice that they sometimes display a +
or - sign after the each of the co-ordinate numbers. This indicates that the value shown cannot be
represented using the current units precision.

16647.53+(|23706.5+

The minus sign (-) (when displayed) indicates that the number is slightly less than the last digit
shown, whereas the plus sign (+) indicates that the number is slightly more than the number shown.
With the precision set in the Units dialog and the available space in the co-ordinate boxes this
notation allows you to see instantly whether the number is precise or not.

If using Relative co-ordinates, the status bar shows the co-ordinates relative to the relative origin.
This will only return back to co-ordinates relative to the design origin if the system is swapped back
to an Absolute co-ordinate system. Use the Design Properties diadlog located on the Edit menu to
switch modes and change the relative origin.

The furthest box to the right displays the current design Units.

Active Status Bar

The Status bar is dso active. This means that by double-clicking on a pane within it, relevant
information can be modified. For example, clicking on the Abs word will toggle between Absolute
and Relative modes. Other modes, such as Grid: will display the Grids dialog where a change can be
made. The active Status bar includes:

e |ayer, Layer Span, Net, Style (text style, pad style, line style) also editable by clicking on Width,
Size, Line Width, Side, Delta X, DeltaY, Angle and Radius (for arc)

e Units (double-click on coords when not editing/moving item), Toggle Units (mm < > thou toggle)

e Typed coordinatess (double-click on coords)

e Absolute/Relative coords (toggle)

e Current Grid

e Vaiants
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The On-line Help System

Pulsonix provides an on-line help system with detailed information about every item within the
product. You will also find help on general ‘ topics as well as feature items.

At any time, you can press the F1 key to access help in context of the current action, or run help from
the Help menu and selecting Help.

|'_§2 Pulsonix Help

e f) A
Hide  Back Home  Font

Contents  Index  Search  Favorites

Type in the keywond to find:

||wor|d

Colours

Copy Out

Copy Out Design tem

Copy Out Library tem

Designs to Vault

Enter Next Vault Revision

Enter Vault tem to be Replaced
Folder Name

5 @

Print  Options

World View A

The World View window provides an additional view of the whole of your current design. it also
provides full Pan and Zoom functicnality to allew you to easily select the exact area of your
design in which you wish to work.

Shortcuts

Toolbar: None

Default Keys: W

Default Menu: View > Dockable Windows >
Command: World View

Folders The World View Window
Getting Started
Groups The World View displays a simplified overall vi="-

up to date as vou pronr-

Installation

likrarian b Vst

T

Index Navigation Pane

: Topic Pane
Entries

The help window is split into two main sections. The left hand navigation window displays the
Contents list, the help Index, aword Search facility and a Favourites selection for retaining pages
'marked' by you. The right hand Help window provides you with the context help pages. These pages
are located from one of the options on the left hand window or by using the F1 key to obtain context
help on each dialog. To view any of the topics that appear in the Index or Contents sections, double-
click the mouse while over the item required. Alternatively, select the item and click the Display
button.

When using the Search facility you can search for word strings by encapsulating the string in double
quotes, e.g. “Free Angle”

Customising Pulsonix

Overview

Toolbars

Pulsonix provides you with the ability to customise the user interface with your own Toolbars
containing option buttons that allow instant access to tools within the program. You also have a
complete command set of al the options within Pulsonix which can be assigned to ashortcut key
from the keyboard. Other aspects of Pulsonix can be customised such as the Windows, colours etc.
but are discussed in other more relevant sections of this manual.

Toolbars in Pulsonix can be set to be both 'docked and ‘ floating'. They can also be customised to
contain your own choice of options and can be named for instant recognition for particular tasks, for
example named Edit Connection, for use in Schematics that might contain connection editing and
naming options.

Below is an example of adocked toolbar. The toolbar is docked below the Menu bar in the horizontal
position. This is the default position but can be moved as required.
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i1 Pulsonix - [PCE Design: ILF3E098 |

Gripper @ File Edit View Insert Setup Utiities Tools
Bas > D@EI& om0 & R K
I ‘

In docked mode, atoolbar is fixed along any of the four borders of the main window framework in
either a horizontal or vertical position and will have a Gripper bar across the top or down the left.
Y ou cannot modify the size of atoolbar when it is docked.

-4 Pulsonix - [PCE Design: ILF3EQ09
B Fle Edit view Insert

) #0EH @~ ;.

The toolbar can be moved by selecting the window border and 'dragging’ it away from its current
location. By dragging it, it becomes detached from the framework. When the toolbar is then moved
over another area of the framework to which it can be attached, it changes shape to indicate it can be
docked there. You can adso make it floating by Double-clicking on the window Gripper bar or in the
toolbar area itself, but avoiding the buttons that will select an option.

The toolbars can aso be floating. This means the toolbar can be moved into free space on the design
and outside the framework. This toolbar can now be reshaped to make it fatter or thinner by dragging
the outer edge in or out. The toolbar can be shaped to be one tool wide or long by as many tools as are
loaded on the toolbar in the opposite direction. By selecting the outer framework edges of the toolbar
asmall arrow 'handle will appear to indicate that the toolbar can now be reshaped. Drag the handle
until you have the shape you require.

Uth Uhe
THE12R THS1E

5 13 k] 3

] ]

T

L
T s ]

Y ou can restore the toolbar to its last docked position by double-clicking on the name caption on the
toolbar.

To move afloating toolbar, select and drag any part of the toolbar framework. The toolbar will move
dynamically with the mouse movement. Release the mouse button to release the toolbar.

How to customise toolbars

Toolbars can be customised to contain the buttons (and underlying options) of your choice. Pulsonix
provides a default set of toolbars that cover different design types and some designs tasks, such as
editing etc.

Y ou can cregte toolbars for any task that appears on the menu or context menus.

To edit or create your own toolbars you must use the Customise option on the T ools menu. Oncein
this dialog you can move tools on existing toolbars or add/create your own. Other than in this dialog,

you cannot add or remove tools from toolbars but buttons can be moved by pressing the Alt key and
dragging the button from one toolbar to another or off the toolbar to remove it altogether.
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P To create a new toolbar

1. Onthe Tools menuy, click on Customise. Click on T oolbars. The Customise option is aso
available by clicking the right mouse button on the Pulsonix framework.

Customise X

Commands Toolbars Tools Menu Keyboard Application Look  Options

Toolbars:

O S - T
[JAnalog

[JAnalog Behavioural Reset Al
[[]Define Pad Shape

[ Digtal Mew...
[]Digital Generic

[1Dockable Views Rename...
Edit

[OMacros Delete
[IMagnetics

Menu Bar

[IMiscellaneous ] [ Show test labels

The process for adding a new toolbar and adding tools to it would be:
2. Click on the New button.

3. Typeinthe name that you wish to use for the toolbar (this is the caption name that appears as the
toolbar title), and click OK.

This name now appears in the list of available toolbars and is, by default, already selected at the top
of the toolbar list. You will also be able to see the toolbar in the design window. You will now need
to add the required commands to the toolbar.

4, Click on the Commands tab.
Customise >

Commands  Toolhars Tools Menu  Keyboard Application Look — Options

Cateqories: Commands:
ILiE al Ch Block Port al
Doc Symbols | L °
Edit Change Branch Paint
File
Find Change Bus
Help
Insstt Change Default Style
Macros Change Doc Symbol
Output
Part Edit v Change Layer v

Description:  Change the block port used by the selected item

The Categories are arranged in the same order as the menus themselves. By clicking on each of the
names in the Categories list you will see the buttons for the options found on those menus displayed
in the Commands section next to it. You can also view all of the available commands by clicking on
All Commands in the Categories list.

5. Click on acommand from the Commands list.

You will see abrief description of the function of that button in the Description: box. These buttons
can now bedragged onto atoolbar. Once the toolbar is populated with the tools you require, click the
OK button to close the Customise dialog.
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P To remove a button from a toolbar

1. Onthe Tools menu, click on Customise.

2. With the toolbar on which the tool to remove resides visible, select the tool button and drag it off
thetoolbar and into 'free’ space. That is, space that is not part of this or any other toolbar.

3. Once complete, click onthe OK button to make the changes permanent.

In addition to using the Customise option from the T ools menu, you can aso use a more convenient
method through aright mouse shortcut.

The context menu is available when the cursor is hovered over any of the toolbars, menu bar or status

bar.

Popup Toolbars

Popup tools are similar to toolbars except that additional toolbars can be launched from them rather
than just a single option. The standard Parts popup toolbar shows an example of this type of toolbar.

P To create a popup toolbar

1. From the T ools menu, select Customise.

Customise

Commands  Toolbars Tools

Categories:

Repors
Setup
Simulation
Tool Palettes
Tools

Ltilities
View

Windows
LIER T P

ser's Components

v

Menu  Keyboard Application Look  Options

Commands:

E Tool Palette 1

2y Tool Palette 2
Ty Tool Palette 3
Ty Tool Palette 4

5y Tool Palette 5

&) Tool Palette 6

Description:

Lz to access tool palette 1

2. You must use the User' s Popup tool from the list, and add one of the special buttons to a new or

existing toolbar.
Click OK to close the Customise dialog.

N o b~ ow

Enter the name required and click OK.

Y ou can name the Toolbar by using aright mouse click over the popup tool.

Go back into the Customise dialog and check the Named toolbar.

Y ou can now add tools to it as you would for any other toolbar. Click OK to exit.
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Using the Customise option, you can aso assign Part buttons to atoolbar, and to a popup toolbar.
This will give you access to Parts of your choice using atoolbar button rather than using the I nsert
Part option.
P To add a Part button to a toolbar
1. From the Customise option, select Commands.
Customise X

Commands Toolbars Tools Menu Keyboard Application Look  Options

Categories: Commands:

File A ¥ ~
Find | A-D Converter

Help ¢$ A Currert Source

Insert +

hq:iros (":3' AL Source

Output .

Par Edit T AND gate 2input

{r AND gate 3input

Reports )

Setup v & Bias Cument Marker y
Cires dmdimem

Description:  |nsert an analog to digital converter

2. Youwill see aParts toolbar, this is a pre-defined toolbar used for the Pulsonix Spice simulation
tool but can be customised for your own Parts, or;

3. You can scroll down the Categories list and use the User’s Components to add generic Part
buttons or Doc Symbols to the toolbar. Only the ones availablein the list can be used up to a
maximum of 15 available.

4. To change the Part selected from the Parts library for the Part button, once the button has been
added to atoolbar, right click on the button to change and edit the Part name in the Part Name
box.

Change Part Name For Button 4

Button: User Part 1

Part Name: |F|esist0r [£ Shape]

Concel

5. Click OK to confirm the name and exit.

Commands and Shortcuts

As well as the toolbars, Pulsonix has the ability for you to programme your keyboard for commonly
used options or commands. This means that once programmed, you can press akey or key
combination to enter afunction or option. For experienced users, this makes the program's operation
far more efficient.

When Pulsonix is first installed, you will find a set of shortcuts aready defined for you. These are
only a default set and can be modified to your own preference through the Shortcuts didog. Almost
all of the keys on a standard keyboard can be utilised giving you extensive coverage of shortcuts.

P To create a shortcut

1. OntheTools menu, click on Shortcuts.
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Customise x

Commands Toolbars Tools Menu Keyboard  Application Look  Options

Category: Fitter

All Commands ~ | |
open | —

Open Page

Open PCB Design Assigned Shortcuts:

Optimal Posttion -
Optimal Rotation Cird=0 Remove
Optimisation Mode

Optimisation Mode Continuous v Reset Al
Description: Press New Shortout:

Open an existing document l:l e

Assignment Report:
By Command By Key

Each of the currently Assigned Shortcuts is displayed when the command of the same name is
selected. It is possible to assign more than one shortcut to acommand if required.

2. Sdect the option you wish to change and click the mouse in the Press New Shortcut window
and then click the key(s) you wish to assign to it.

Click the Assign button and that key combination will be assigned to the function chosen.

4. If the key has already been used, a message will be displayed informing you that it is aready
assigned allowing you to overwrite it or Cancel.

5. Before any shortcut keys are assigned ready for use you must exit the Shortcuts dialog by
pressing OK. Simply, assigning the shortcut is not enough.

A full report of al the assigned keys can be obtained from this dialog or can be run from the Reports
option on the Output menu. Use the Shortcut Keys Report to generate the report.

Selecting a Category from thelist of categories a the top left of the dialog causes the command list
to show the commands in that category. The <All Commands> category shows al available
commands. The Description box displays a brief description of what the currently selected command
does. These are categorised using in-build categories and cannot be changed.

The Find Key and Filter options dlow you to locate other shortcut keys.

The Menu Bar

Like the other toolbars, the M enu Bar can bedocked or floating but the menu item names cannot be
changed. The visibility of the Menu bar or menu names can be changed using the M enu Bar option
on the context menu. If amenu name is removed from the Menu bar it can be restored by selecting
the Customise menu and T oolbar s tab, and selecting the Menu Bar name from the list and clicking
the Reset button.

File Edit View Insert Setup Utilities Simulation Tools Qutput Window Help
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Mouse Operation

The mouse is used extensively throughout the use of Pulsonix, not only for menu and option selection
but aso for interaction within the design.

The standard left and right mouse buttons provide selection and context menu functionality
respectively (these can be reversed using the mouse controls built into the Control Panel).

Before using the 3-button wheel mouse, you may need to install amouse driver that enables the wheel
to be used. Use the Control Panel and Mouse control to setup and enable the mouse driver. Consult
the manual that accompanies the mouse and driver if you are unsure about setup details.

As well as the shortcut keys, Pulsonix has been equipped with the Pan and Zoom functions on the
mouse wheel and wheel button, (e.g. available on the Microsoft® Intellimouse). This feature is only
available when the wheel mouse is enabled using its own software, and if the wheel mouse pointing
device is attached.

Microzoft (R) Intelimouse
[recammended)

Wiheel rolled backwards
= Zoom Cut

Wheel pressed dowven and
releazed = Single Pan
Wheel pressed dowven and
held while moving mouse
= [ymanic Pan

Wheel rolled forvwards
= Zoam In

When the wheel is pressed down and released, asingle Pan is performed centralising the design to
cursor position, (the same as the <P> key). Keeping the wheel button pressed down will enable
panning of the design until released.

When the wheel is rolled forwards (without being pressed) aZoom In is performed to the current
cursor position (the same as the <Z> key). If the wheel is rolled backwards (again, without being
pressed), aZoom Out is performed to the current cursor position, (the same as the <U> key).

3D STEP Preview

When using the 3D STEP Preview option in Pulsonix, you can also use the 3DConnexion
SpaceMouse. This should be installed suing the appropriate mouse driver. Pulsonix will support the
mouse buttons in 3D mode.

A special note too about mouse operation within the 3D Preview — the right mouse buttom press
requires the Ctrl key to also be pressed to enablea view rotation of the whole design.
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Dockable Windows and Browsers

Overview

World-view

As part of the design suite, you have a number of dockable windows and Browsers that can be used to
view specific design information. These windows are available through the View menu, through
Shortcut keys and through the popup toolbar/window menu. Each individual window can be
specified to Allow Docking (enabled through the context menu for each window or browser). This
means that if not allowed, regardless of where the window is placed, it will not 'attach’ itself to the
framework. If you require it to be docked, the Allow Docking option must be checked (with the 'tick’
showing as in the example below).

Floating
Docking
Auto Hide

Hide

Show Design Extents
Show Board Extents
Show Working Area

Component Bin B
Design Browser D

H Part Browser

E’E: DRC Errors Browser
Find Bar Ctr+F
el

2 lavarc Rar

The world-view is aminiature view of the complete design with some detail included for co-
ordination. This world view is used to navigate around the design, and because you can see the whole
design you do not need to resize the design first.

World View X

= Board outline

A

Current view

Design items

This browser can be used docked or floating (shown above as floating). Not only does it provide a
view of the design but can also be used for navigating the design as well. The Zoom infout, Pan and
Fame View commands are all operative in this view and are highlighted by the white Current View
box.

Options are also available on the context menu by clicking the right mouse in the window.

By right clicking in the World View you are presented with three choices of the view to show: Show
Design Extents, Show Board Extents and Show Working Area.

The picture below shows the World View with the view set to Working Area. You can see dl of the
design areawith the design represented within it.
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World View X

World view ——

Current view —-

Board outlin

Other selections on the context menu will display the browser options also available.

Component Bin

The Component Bin is provided to store and view unplaced components in the PCB design editor,
and unused gates in the Schematic design editor.

When used in Schematics it contains unused symbol Gates not yet placed. For example, if a4xNAND
gate is loaded into the design but only one gate placed, the other three gates are placed into the
Component Bin ready for subsequent use.

If used in the PCB design editor, the Component Bin is used to hold unplaced components. The
Component Bin can be used as an integrated part of the auto place functionality. The components are
automatically taken from the Component Bin and placed on the design, this can be atwo way process
for removal of components from the design.

— Preview window

31 - DI5F-30 . i
U1 - ISPLST1032-80LT Component bin

The Component Bin is adockable toolbar. It can be left 'floating or 'docked' on one of the sides in the
design area. To moveit, simply click and drag an edge of the Bin to the desired location. The
Component Bin will move while being dragged, as soon as you release the mouse button it will
remain in its present location until moved further.

The Component Bin contains two sets of information.

The Component Bin Preview window shows the Component currently selected in the bin, along
with its terminal/pad numbers and names. T his updates automatically as each Component within the
Bin is selected.

The Component Bin window lists the components currently in the bin. This shows the Component
reference name, the Component name and Component type and is sorted aphabetically on the
Component reference name. For a schematic design and for a multi-gate Component, the gate name
and symbol name are listed for each gate of the Component. The components (or getes) are selected
by clicking in this list.

Using the Component bin
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Components can beplaced in the Bin directly from Insert Component, from Translate to PCB or by
dragging them manually into the Bin from the design. Y ou can also select components in the design
and send them to the Bin using functionality from the context menu. Any PCB Components within
the Component Bin retain all connectivity but loose track information if previously routed in the
design. You are warned that track information is lost before the move to the Bin can be made.

Any Schematics gates moved to the Component Bin become completely unconnected (unused).
Components within the Bin can be moved from it in a number of ways:

Y ou can select and drag a Component from the Preview window or from the Component list. This is
the most basic mode but aids fast manual placement by making the design 'clutter' free during the
placement phase.

If you select Place Around Board and components are in the Component bin, they will be placed on
the design around the board outline.

Auto place (if authorised) can move components to and from the Component Bin automatically.

Further selections in the Component bin
By right clicking in the Component Bin you are presented with a number of choices:

Add to Bin will open the Insert Component dialog from where you can draw components and add
them directly to the Bin without exiting this option or mode.

Delete from Bin will allow you to delete individual components from the bin. This is only available
in PCB if the PCB Safe M ode is not active in the Options dialog (available from the Settings menu).
If active, you will not be able to add (Insert) or remove (Delete) items from the bin.

Empty Bin will remove any whole unused components from the bin. If any gates or Connector pins
are already in use in the design they will not be removed.

Place Around Board From Bin will place selected components from the bin to around the board
outline, provided one exists.

Component Bin X
1C1

I I I I Eloating

Docking

iy | =

Add ko Bin

Delete from Bin

Ermnpky Bin
02 - 50723
R1-F W Place Around Board From Bin
L1 - 744110000
Q World Yiew W
_E Design Browser D
] Davk Pramcar

The other browsers are also available for selection on the context menu.

The Component Bin is discussed in more detail as it is used throughout this manual.

Part Browser

The Part Browser provides a convenient way to add commonly used Partsto your design.
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Change Part: Categories...

Part: AS45X08A-TC100

Attributes: Refresh Part Browser
<Part Description> = 5X-A FPGA
<Part Family> = A545X Change Fitter...
E’Iaftrezg?ﬂ«rftgl I(CIFPOAISIA [ Edit Part In Library
Insert Component  Shift+C
Vault:
Part: *il Add Component To Bin
= Manufacturer (69428) View Symbol Extents
-- <MNo Mfr= gk Edit Symbol In Library
-3M
E| Actel
.. Ad
- A545X
M 1515X08A-TQ100

- AS4SX0BA-TO144

- AS4SX08AN-TQI00

i ASASKDBAF-TQI100
f.. ASASX16A-TQ144

- APA

- D5

- eXB4

- eX128

- X256

- AD

- Altera v

Adding components to the current design

Y ou can add components to your design by selecting a Part in the browser and dragging it into the
design, with the left mouse button held down. You will then have a Component on your cursor that
you can place by releasing the mouse button. After the first Component is added, more copies of the
Part are interactively added to the design until you cancel the current command, or begin a different
command (including dragging another Part from the browser).

Configuring the Part browser

The browser presents alist of Parts organised according to a category éttribute. The list can be
hierarchical by specifying an appropriate separator character to split the atribute value into a path.
Y ou can change the attribute used and the separator character by selecting the Change Part
Categories on the context menu in the browser.
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Use Name Branch Attribute Split Character Filter Attribute Filter | No. Pins
[] | Manufacturer <Multiple Branches=
[] : Part Number <Part Famity= ! Category Ind*
[ ] : category Category !
Edit Part Category *
Marne: | Category | [& blank Mame will use a generated description in the browser]
Part Categomy Tree:
Or Branch Attribute Split Character Add
Category !
Delete
Up
Dioven
[ Show Unsatisfied
hich Parts:
or Filter Attribute Filter Type Filter Add
Delete
Number OF Pins: l:l
Caresl

0K

Cancel

Mew...
Copi...

Edit...

Delete

Up

Down

Y ou can select more than one Category to list in the Parts Browser. This uses a grid where each row
defines a category name. This also dlows you to Filter the Parts using wildcards on an attribute value,
or specify the required Pin Count (No. Pins).

Once the OK button on the Part Browser Categories dialog is clicked, the Part Browser will be
updated with the new selection.

These attributes are the ones currently in your library indexes, to change this list you must regenerate

the library indexes using the Index option on the Parts Library Manager dialog.
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Design Browser

The Design Browser is displayed as aconfigurable Dockable Window containing a list of all the
currently open PCB and Schematic designs, technologies and profiles. For aSchematic, atree
showing all the pages in the design is shown, including any hierarchical blocks. The name of the
design/page whose view is currently active in the main window is shown in bold typeface. A dimmed
page icon indicates schematic pages that are not open as a view in the main design window.

Design Browser X I
Job2022
Floating
Display Docking
- ToP
+- I8} CTRL [Cantroller
=18 LD1 [7 Seqment Hide
Pagel
=-J& LDz [7 Segment Open Page
Pagel Close Page
=18 LD3 [7 Seqment
Pagel Delete Page
+- 18 LD4 [7 Seqment Rename Page
+-{& LDS [7 Segment Move Page Up
+-{& LD6 [7 Segment
= E LD7 [7 Segment Maove Page Down
+-{& LD [7 Segment Mew Page
Bl 1ob2022
B Close
0 whterld s e

As well as being avisual guide, the Design Browser is fully functional and provides access to arange
of design level operations via its context menu.

» To show/hide the Design Browser

1. Fromthe View menu, select Design Browser, this will toggle the visibility of the Design
Browser window. Alternatively a shortcut key can be defined using the Customise option.

Using the Design Browser

From within the Design Browser:

e Double-click on a PCB design to make that the active view within the main design window.

e Double-click on a Schematic design or one of its pages to make that the active view within the
main design window.

e Double-click on an already active Schematic to hide/show its pages.
e Double-click on an unopened Schemetic page to open it.
e Click on any design or page to make that the currently selected Design Browser item.

e Right click anywhere in the Design Browser window to display the context menu that provides a
set of design/page level commands applicable to the currently selected item. Commands such as
Close, New, Delete and Rename operations are available.

DRC and ERC Error Browsers

These browsers are used to view the design error markers that have been created by the Electrical
Rules Checker, by the Design Rules Checker or by the on-line design rules checking options. The list
is displayed in an 'active’ browser. You can use adouble click on one of the items in the list to locate
the error marker in the design. This browser can be un-docked as a modeless dialog or docked as part
of the Pulsonix framework. Use the right hand mouse button to make this selection.
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Before using the Errors Browsers you must first run a design rules check from the T ools menu to find
and 'mark’ the errors. Errors found during the on-line DRC/ERC processes will also be displayed in
this list.

The browser is categorised in hierarchical order of ‘rank’ starting with Design (number of DRC
errors), then Layer, then Error type, then the Marker itself.

Floating
Docking
Hide
ERC Errors
= DRC errors: 2 0 Clear all Errars
B3R Component to Component Error (Crn-Cr 9
Flash Errors
=I- Pad ta Track Error {P-T} Lt
=I-Layer: Top H Design Rule Check...
Pad to Track Error {P-T) Mets " and 'Gnd'. Required 0,25 Actual 0. DRC Errors Report
Toggle Sort Order
Q Warld View W
il Faranenan + R 3

Each error marker is shown as an X,Y co-ordinate within the design. You can locate an error marker
by double clicking on the co-ordinate.

An error marker is a code used to denote aspacing or design rule violation and is created by the
design rules checker. Design rules errors are created when two design items violate their respective
spacing or design rule. A report can also be obtained for all of the error markers in the design by
using the right hand mouse context menu when in the browser.

Any error markers in the design should be cleared by running the design rules checker again. This
will be an iterative process and you may need to be run the DRC option more than once or until all
errors have been satisfactorily removed.
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Layers

The Layers browser alows afast display and switching of layers without using the Colour s dialog.
This modeless dialog is displayed as a configurable Dockable window containing alist of all the
layers in the design. The checked layers are currently visible in the display window.

Layers X
i
W Silkscreen Top ~
1M Faste Mask Top
I W Solder Mask Top
[ Top
B 2> Ground
Irirer 3
Ininer 4
W Inner §
Irirer B
B Pawer
Battom
[ Solder bask Bottam
] W Paste Mask B ottom Floating
Silkgcrean Bottom Docking
W ‘Wires Bottam Auto Hide
Pir M ames [Bottom) Hide
(W Documentation
B Construction Lines SllEvesion
W All Layers Off
. i This Side On
Hide << Show Pick his Side OFF
Areas ) This Side
D (2 Switch Displayed Side
Bl Set As Default Track/Copper Layer
Camshucts: Show Item Layers
Copper: Set Toggle Layers...
Pads: &% Technology T
Rauting: 3 Colours C
Ve .@ Load Colours
Pirt Mame in Pads:
Locked Items: @ Save Colours
# Warld Wiaw A

From the context menu you can aso select options from the context menu. These further enhance the
selection of layers and layer combinations.

Switch Displayed Side is used to switch to the set of layers for the opposite side of the board, e.g. All
Top or All Bottom. This is also available as a command from the Run Command option on the Edit
menu.

With an item selected in the design, the Show Item Layer will be displayed. You can then switch off
all other layers other than that one.

Double-clicking on one layer name will switch off all other layers.

Active Layers

The colour squares within the Layers bar can have a black square outline around both the default
electrical and documentation layers. Click on the square itself to set that layer as the default. If there
is no common default (i.e. all categories do not have their default set to the same layer) the black
outline is not drawn.
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[l Sikscreen Top
[ ] M Solder Mask Top

[ ] Paste Mazk Top
[] PinMames

] Top

When starting a new track or adding a new doc shape, the default layer defined here will be used.

On the context menu within the Layers bar, the selections for the default layer change depending on
the layer type selected (Electrical or Documentation Layers):

Al Layeis OFF Aii cayeis UTT

This Side On This Side On
This Side Off This Side Off
22 switch Displayed Side (2 Switch Displayed Side
Set As Default Track/Copper Layer Set As Default Documentation Layer

Show Item Layers Show Item Layers

Set Tnanla | avare Set Tancls | avars, .

Showing and Hiding Powerplane Layers
Powerplane layers (Layers nominated as a Bias of Powerplane in the Technology fil€) are indicated
by a small white thermal pad icon to the right of the layer colour square.

[_ipmm IOR

q iy ﬁplit Faower Plane

M1

P Wl mrrng] Plame e

If the powerplane is being displayed (using the View Power plane mode), theicon is in negative.
Click on the icon to display or hide the powerplane. The icon changes to a positive format to indicate
the powerplane is active.

B B Split Power Plane

The functions to display, regenerate and hide the powerplane are also on the Layers bar context
menu.

O Pinames
CIm Tep
] . LY
ESEND Floating
OmESHM Docking
| 3 se Auto Hide
1M Batton - o
] Sikse Hide

Solde
E Paste All Layers On
[1H Docu All Layers Off

Hide << This Side On

This Side Off
J< Switch Displayed Side

Set As Default Track/Copper Layer
Display Power Plane

Show Item Layers
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Find

More>> and <<Hide buttons

Thelist at the bottom of the Layers bar contains other dockable bars that you may wish to use. If you
click on one of these, it will become visible and replace the Layers On/Off bar. This alows you to use
adockable areafor just 2 bars (for example) and keep replacing them with the next bar you wish to
use.

The Find item browser is available as a dockable bar. Using the shortcut key <Ctrl-F>, you can find
and select design items using the drop down list box.

Find (0 items found) x

=l x| Wi [ (A (B

Area

Azzociated Part
Altribute Position
Branch Point
Component
Connection
Copper
Ditferential Pair
Doc Symbol

Drill Size

Errar

Favourites
Faootprint

Group

Item  [by attribute]
Line Style

I ounting Hole

Met Class
Pad [by name]
Pad [bynet]
Fad Style
Part
Serpenting
Signal Path
Star Paint
STEP Model
Sub Met
Template
Testpoint
Text Style
Track

Track Style
Via

Wine

I
The dialog presents you with a list of items from which to choose.

The list will show named items of the selected type in the design. In the example above, components
are shown. If the item type does not have names (e.g. Copper) then a list of nets containing items of
the chosen type will be shown. If the item type is Errors, alist of the possible error codes is shown. If
the item type is Attribute, alist of the used attribute names is shown (see below).

Click on anamed itemto find it in the design. It will be highlighted (or optionally selected) and
optionally centred in the display window. If the list contains alist of nets, click on the required net or
use <Search entire design>. The first item of the required type on the chosen net (or entire design)
will be found.

On the browser bar are two additional sets of icons. The set on the lft side are permanent and are
used to find components, Nets and X,Y positions. The second set on theright side is item sensitive
and are not enabled for every item type.
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Find (42 items found)

[ AT 1) [ 0 l
Net l_]

The ‘pin’ icon on the left hand side is for ‘ latching’ this browser if ‘ floating’ and is discussed below.
The three other icons are for Finding the First item in the list, Finding for Next item and Finding
for Previous item.

Once items have been found (using any conditions from the Filter options, if filtering), the Find First
will then start the search on the first item. Next and Previous will toggle through the list of found
items if there is more than one item found.

The Find context menu

From the Find Browser you aso have options available on the context menu to find and display
found items.

Find (42 items frem-d I
Floating
) E Docking

et Auto Hide

DRIMNE Hide

DRIVE

Feedback Include Default Nets

ENE Select Found Item

igh_zpe

Low_spee ZI Flash Found Item

MOl

NO4 Centre View on Found Ttem
W05 T
N7 ZI Add Found Item to Favourites
MOg

M09 Refresh Find Bar

MNOE

NOTg Count Found Items

winnn *%  Select All Find Ttems

¥, Select Visble Find Items Crr+A

Remove Highlights

Deselect Al

# wiarA Ui ity

The flashing of items is controlled by the Options dialog and Find page.
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8" Options - Find
Design Backups Action On Found tem Finding Nets
Display
Edit Shape Select f Include Default Nets
Edit Track Flash k
File Extensions 1 Certre View On Finding Emor Markers
Find
¥ Gm | [] Mllow Find Under Sliding Bar Include Locked Emors
enera
In-Place Mames [2] Add To Favourites List [+] Only List Ermors In The Design
Int ti
nteraction Flashing kems Finding Dirill Size
Macros
Move Flash For: seconds Use Drill Table Units
Multi-Screen
Online DRC Schematics Search Variants
Resolve Net Names
Select (®) All Pages Search In All Variants
Synchronisation () Open Pages
Tooltips () Cument Page Favourites List
Track Length Limits ) )
Warnings Mzxdmum ftems In List:

The Item Filter in Browser Windows

Some of the browser windows have a Filter mechanism so that item searches can be made on
specified criteria

To use this option, click on the Use Filter or Change Filter button if you want to further define the
search criteria and reduce the number of items to find. If the button has the text Change Filter, then a
filter is currently being applied to thelist. When the button is selected a set of extrafilter controls will
appear to use, these are detailed below. When the Hide Filter button is selected, thesefilter controls
will disappesr.

Check the Filter Names checkbox to enable the name filter control. If the Find list contains alist of
named items (e.g. components) or net names, type the filter string containing wildcard characters *'
and '? into the control underneath the Filter Names checkbox. Use the drop down list to obtain filter
strings previously used for this item type. When the filter string has been changed the Apply button
will be enabled. Press Apply to apply the filter string to the list of names.

Hide: Filter <<

Apply
Filter Names

I

Attribute;

<Component Height> w

2mm 3

Further filtering of items can bedone using an attribute condition. Check the Attribute: checkbox to
enable the attribute condition controls. Use the dropdown list underneath the Attribute checkbox to
choose the atribute name you wish to use. Next use the I's dropdown list to select the type of test to
apply to the attribute value. Then, in the remaining edit box, type in a string representing the
condition to test against.

Press Apply to reduce the items to be found to items that satisfy the attribute condition. The attribute
filter applies to unnamed items as well as named items.
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The ‘pin’ status of Dockable bars

The pin on some Dockable bars is used to show whether the dialog is latched or not. In an unlatched
status (shown in the picture below but only applicable if ‘ floating’ ) once an item is selected from the
list, the dialog dismisses itsdlf. If the pin is latched, the dialog is persistent and aways displayed until
closed by you.

nd (42 items found
HIWE

Selection Mask Window

Find (42 items found

T

The Selection Mask toolbar allows you to choose design items that are selectable within the design
and save the mask for subsequent reuse.

This option is available from the View menu and from the custom menu enabled by right clicking on
any of the Pulsonix framework (enabled the same way as the Design Browser, Part Browser, World
View etc.). It can also be enabled by right clicking on any of the existing open Browser windows and
selecting it from the context menu.

Selection Masks * 0 X
Save || New

Enable Select Mask
<Default> |

Area
Attribute
Bitmap
Board
Bond Pad
Breakout L
Companent ||:|Wire |
Connection

Construction Line [~] Additional Mask Parameters:

Copper - i
Dimension Line Style:
Doc Shape 3
Doc Symbal | |“' | S
Embedded View Aftribute:

Ermor

Junction
Mourting Hole
Crigin

Pad [GND | &
Teardroj
] Overide Select Options:

?5‘90“ Frame Select:
ot
T?ack ||f Inside: Frame v |

‘\‘:"I‘f" [] Select Tight Groups
Wire
[] Do Mot Pick Locked tems

|cNet MName: v|

ls: |matching w |

[] Additional Mask Parameters:

Using the browser dialog

Y ou can use the Selection Mask on atask by task basis or you may prefer to create a selection mask
and save it for subsequent use.

You can create alist of selection masks that can be defined and saved. Y ou might create a number of
selection masks for all Track and Pads for example.

To ectivate the Selection Mask and start to use it, select the Enable Select Masking check box.
Without this selected, nothing happens. Initially, the <Default> selection mask is shown. This is the
selection of check boxes in the list as currently set. If you change the selections and press the Save
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button, this then becomes the new <Default> selection. However, you may wish to be more specific
about your choices and to reuse them.

Y ou can save multiple named selections by pressing the New button. When this button is pressed, the
Create New Selection Mask dialog is displayed. When the Create button is pressed, the selection
meask is saved. Using the Copy Current Selection Mask will enable you to make the selections, then
save them. You could aso use this to make slight modifications to an existing selection mask and
save it to another named selection.

Create Mew Selection Mask it
Mame: | Compoent & Pads | | Create I
[ copy Current Selection Mask Caneel

The drop down list on the Selection Mask dialog displays dl previously saved Selection Masks
e &Rt BE

Selection Masks * I X @

Save | Mew Q
Enable Select Mask E
| I~ |2
<Default> @
T 3

| | Attribute

[-7] Btmap -

Check box options on the Selection Mask Dialog

There are additional filters to enable refinement of the selection. With Pads selected, selecting the
Additional Mask Parameters enables the Pad Style drop down list from where you can choose apad
style. This can a specific pad style or can be awildcard name. The Wildcard wizard helps you create
the name.
l et

[ Track

[via

[Jwire o
[+ Additional Mask Parameters:
Pad Style:

I Rect (0.2mm x 1.5mm)1 | | &

With a Pad style selected, you can then only choose pads that match that style.

Inspector Bar (Dynamic Properties)
The Inspector Bar acts as adynamic Properties windows, however, it is different.

Accessed by right clicking on the Pulsonix framework and selecting I nspector off the list of bars
available, or access it from the View menu and selecting I nspector Bar. Generdly speaking, the
Inspector Bar would be left either docked open or floating so thet it is accessible instantly.

With an item selected, the Inspector Bar will display Properties for that item, for example, a selected
Component in PCB:
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Inspector x Inspector
Selection N Selection n
Component: IC4 {ATMEGA16U2-MU} Connection {+5V}
Lock B Lock n
Locked O Locked O
Transform o Met -
Position |'|5-535 | |3-4-?53 | Source All Mets In Design
Angle |5D-D | Mame <5V w
Mimored O Sub Net Only
Layer o
e
Layer <Top Side>
| Cwn Colour I -
Explore Net =
Explore Net i
Component = Met
Name c4 | Name <5V
Part [ [ATMEGATBU2MU || change... Foes
Description [ [Bbit Microcontrollers - MCU AVR USB 8K FLAS| Nodes ] "
caz2
Part Family O | Atemate... C12.2
Footprint [ [@FN50P500X500X100-33N [~] 01
LCD-PIN1.2
Pin Names ] R2.1 v
Pin Logic Names [ ] Component
Auto Footprints Name
Part 22-27-2061
Component Attributes = Nets <16
Name Value Visible | Source A :} é
<STEP Filename= |ATMEGA16UZ-MUs [ ] Part 533
Allied_Number [ Part
DatashestLink  |http-ww . microchi [ ] Part Gnd
Height 1 W Part v A

Context Menu Options
By right clicking on the Inspector Bar, you can access additional commands:
Change Group Order

Select Change Group Order to rearrange the ordering of the 'groups' or sets of properties displayed
in the I nspector Bar.

Use the Up and Down arrows to move the selected group up or down in the Inspector Bar list.
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Groups can be shown or hidden in the Inspector Bar using the check boxes next to the group or by
using Show All/Hide All.

8" Change Group Order

Selection
Lock

[ Transform
Layer

Met

Component
Line Style
] Text style
/1 Pad Stule

Explore Net

v

=]
~

Cancel

Up

Down

Show Al

Hide Al

Explore Net

Explore Net

3

Net
5V

T

Name

Class

=
[=]
H
3

Nodes ci1 ~
caz2
122
9.5
J10.1
LCD-PIN1.2
R2.1 o

i

Component

Part 22-27-2061

Mets $16

Find Options

Single Clicking to Navigate Nets & Nodes
Single click will  navigate' net and nodes, using adouble click will highlight net.

The group Explore Net enables you to see the nodes on a selected net and the nets on the component
(if the node is from a component). This functionality also works in reverse, so for aselected
component, the Inspector Bar will show all nets on that component.

Selecting anode or net from one of the lists in the group will update the other list (Net or Component
or vice-versa), allowing the connected nets and nodes to be traversed (or explored).

This offers the same finder functionality as the Find Bar, with the Find Bar options being used here
as well. These options can be viewed and changed from the I nspector Bar by right-clicking anywhere
on the bar and hovering over the Find Options context menu.
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Floating
Docking
Tabbed Document

Auto Hide

Hide

Select Found ltem
Z‘ Highlight Found Item
Z| Erightzn Found Item
Dim Items In Colour
Flash Found ltem
Centre View on Found ltem

Add Found Item to Favourites

Close All Groups
COpen All Groups

Change Group Order

Shape Information/Editing Bar

The Shape Information Bar appears as a dockable window accessible from the View menu and by
right clicking on the Pulsonix framework. This displays detailed information about the currently
selected shape in agrid format that also updates on the fly. It is available to use when editing PCB
and Schematic designs, Symbols and Technology files. The text in the grid describes the shape details
that may be edited alowing precise modifications to be made.

Shape Information x
4a | Paints ~ o, &,
Auto
Locked[] Closed Filled
Type X Y ~
Start Point 53.2860 38.8620
Clockwise To §5.7860 41,3620
With Centre At | 65.7860 38.8620
Clockwise To 58.2860 38.8620
With Centre At | §5.7860 38.8620
Line To 131.5720 38.8620
Anti Clockwise To 133.0960 40.3360
With Centre At | 131.5720 40,3860
Line To 133.0960 53.0860
Line To 132.5880 53.5040
Line To 127.2540 53.5540
- TRYRE Ee

Check boxes on this dialog relate to existing Shape Properties and can be modified here also.

The Auto button will cause the Shape Bar to automatically switch to the most appropriate mode to
display a selected shape, i.e. if acircle is selected it will be displayed in Circle mode. Polygon shapes
will be shown in the most recently used of the possible modes available.
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The shape information can be displayed in various formats dependent on the current mode selected
from the drop-down list a the top of the dialog (showing Points in our dialog example above). When
adifferent mode is selected the grid columns will reconfigure to display the chosen format. In al
modes, shape points are shown as pairs of coordinates in adjacent X and Y columns in the grid.

Context Menu Options

When a shape is selected, you can right click on arow in the grid of the shape bar and click Find

Segment.

Shape Information

el
4= | Paints | 3]
Auto

Layer: | <Through Board:

Locked [ ] Closed Filed

Type | X

Y ~

Start Point | 832880

38.8520

Clockwise To
With Centre At

Clockwize To
With Centre At

Line To

Anti Clockwise To
With Centre At [

131 &r

FERET-E

Find Segment
Select Row
Insert Row

Delete Row

Line To 133.0960

FrITOUT
53,0880 : ]

This feature shares the Find Bar options (Options, Find, Action On Found Item) for Highlight and
Flashing and will find the chosen segment in the design. If you have the Highlight it and Flash it
boxes checked, then the chosen segment will be found, highlighted and/or flashed.

Find a segment using the grid

Right click the mouse over the row in the grid you with to find in the design. From the context menu
select the Find Segment item. The segment will be located by dtering the view to include it and then
either selecting it, highlighting it, brighten it (dim all other items) or flashing it. The find action
depends on the current Find Options. Find Segment is not available when using Circle or Rectangle

mode.

Insert anew segment into a shape

Right click the mouse over the grid a the point you wish to insert a new segment. From the context
menu select the Insert Row item. A new segment will be insert in to the shape at that point. The exact
position of the inserted segment will depend on the current Shape Bar mode; in a Segments mode, the
new segment is inserted from the centre of the existing segment to its end point. In a Points mode, the
new segment is inserted after the end of the existing segment to the centre of the next segment (if
there is one). In either case, the end point is gridded using a step size relative to the Working Grid .
Insert Row is not available when using Circle or Rectangle mode.

Delete a segment from a shape

Right click the mouse over the grid row containing the segment you wish to delete. From the context
menu select the Delete Row item. The way the segment is removed depends on the current Shape Bar
mode; in a Segments mode, the corner at the start of the segment is removed. In a Points mode, the
corner a the end of the segment is removed. It is not possible to delete segments from a shape if
doing so would cause it to become invalid. Delete Row is not available when using Circle or

Rectangle mode.
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Toggle Layers Bar

The dockable Toggle Layers Bar alows you to activate any of your defined layer toggles on thefly,
while in design. This is available from the View menu and by right clicking on the Pulsonix
framework.

Toggle Layers X
.W

Toggle Top
Toggle Bottom
Show Electrical Top, Bottom

Setup

The Setup button will take you to the Setup Toggle Layers dialog from where you can define the
Toggle Layers.

If you right click on the Toggle Layers Bar, a context menu is available:

Floating
Docking
Tabbed Document
Auto Hide
Hide

View Toggle Mumbers
View Toggle Aliases
View Toggle Shortcuts
Refresh List

Set Togagle Layers...

Three active settings enable you to display additional information if defined in the Toggle Layers
dialog on the Toggle Layers Bar: View Toggle Numbers, View Toggle Aliases and View Toggle
Shortcuts. The Set Toggle Layer s switch will take you to where these can be defined.

Auto-hide Dockable Windows

All dockable windows, such as World View, Layers etc. may be switched to be an Auto-hide
window. This means they can still be docked but now you can also make them docked but visible as a
button to the side of the Pulsonix framework (see below — this example shows three windows docked
on the right side of the design area). When you hover the mouse over one of these buttons, the
gppropriate window * slides’ into view ready to use.
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[Find (75 items found) - ax

) (@

Component

1 [ sesmoigubiseq |

aya

There are three small icons aong the top of this window, (moving left to right) these indicate a drop
down context menu (also available as a context menu in the window by right clicking the mouse), a
pin to enable the dialog to be sliding to conced it or docked to be permanently displayed, and a Close

button to dismiss the dialog altogether.

“Find (75 items found)

o
[da) s Tl

Component

Docking Indicators

When running the latest application look, docking indicators appesar to show

‘ the potential dock pasitions which can then be chosen by releasing the drag
' with the mouse pointer over the appropriate indicator. The docking indicator
@ is different when over an existing docked window.

To reposition adocked window, press and hold down the left-hand mouse button on the window title
bar border and drag the window frame to the desired docking indicator. Any of the four ‘ outside
indicators will allow the window to be docked. By dragging it over the centre indicator, it will be
added to the existing window as a new tab. When used on adockable window it looks like this:

windaw  Help L

Boeneal Mnsmgsenasl
— T w T T T

:'ﬁ;l_
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Outside the main docking indicator are four other position indicators. These show that the window
can bedocked to the adjacent edge of the design area of main Pulsonix framework.

Attribute Editor

The Attribute Editor option presents al the attributes currently in a design (or library) using a
‘ spreadsheet style’ table, this is available as Attributes... from the Edit menu, or the Attributes
button on the Libraries diaog.

B Edit Attributes O >
Attributes of: | Camponents
Apply
Cancel
Add Name. .
Name Part Name Family Footprint <Component Height> | Category | ~ Rename...
C1 (o Generic/CAP | C0305 1.2mm Capacitor/G Delete Mame
c2 C Generic/CAP | C0305 1.2mm ‘Capacitor/G
C3 C Generic/CAP | C0805 1.2mm Capacitor/G -
[ & Generic/CAP | COBDS 12mm CapacitoriG Edi...
C5 C Generic/CAP | C0305 1.2mm ‘Capacitor/G Delote/Resst
Cs C Generic/CAP | C0805 1.2mm Capacitor/G
CcT (o ‘Generic/CAP | C0503 1.2mm Capacitor/G
ca C Generic/CAP | CO305 1.2mm CapacitoriG Copy Tags
C9 C Generic/CAP | C0805 1.2mm Capacitor/G Copy
C10 (o Generic/CAP | C0305 1.2mm Capacitor/G
c11 C Generic/CAP | C0805 1.2mm CapacitoriG Paste
c12 C Generic/CAP | C0805 1.2mm Capacitor/G
ci3 cp CAPPIV Revert
C14 CP CAPP3V
c15 cP CAPP3V Show
C16 = Generic/CAP [ COB0S Hide
C17 C3527 Generic/SMC | C3527 CapacitoriG
c18 C3527 Generic/SMC | C3527 CapacitoriG Colours...
c19 C3527 Generic/SMC | C3527 Capacitor/G
20 Cagar Ganerc/ahc| Casa7 CapacitoriG S e
c21 £3527 Generic/SMC| C3527 Capacitor/G Calhmi et
D1 D Generic/DIOD| DIODO3 Diode/Gene
02 1] Generic/DIOD| DIOD03 Diode/Gene
D3 1] ‘Generic/DIOD| DIOD03 Diode/Gene L5 Tags
D4 D Generic/DIOD{ DIODO3 Diode/Gene Export C5V.
05 1] Generic/DIOD| DIOD03 Diode/Gene | OS5V
06 D Generc/DIOD| DIODO3 Diode/Gene el
D7 D Generic/DIOD| DIODO3 Diode/Gene: .,
< >

Y ou can use this editor to not only view all the attributes and values in use but also to manage
attributes such as adding, removing and editing them.

Attributes for different design items can be designated using the Attributes of: drop down list. The
types of items available will depend on the type of design or library from where you have invoked

this dialog.

B Edit Attributes

Altributes of:

Mets

Pirz

Signal Paths
Sub Mets

Ditferential Pairs

Hame

Part Hame

Family

Footprint

<Component Heigh

C1

c

Generic/CAP

C0305

1.2mm

c

Generic/CAP

CO805
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If an attribute has already been assigned to an item (along with avalue), other items can dso have a
value assigned to them by simply editing the appropriate cell. Editing attribute values can bedone
directly inthe grid, just like working with a spreadsheet. They can dso be modified using the function
buttons provided.

Cdlsin the grid are coloured depending on their 'stat€, indicating for example whether a particular
item has the attribute defined but empty, or defined but hidden, or defined and visible.

The order in which items are displayed in the dialog can also be changed. Right-clicking on the
column heading will display a context menu from which to Sort the Column. You can dso use this to
edit the name or add a new name (attribute) column heading.

Add Name...

Footprint | <C-—=—-—-=t1-iorae [ s Trannector | pa a Rename...
Add Name...

\P| C0805 12 Delete Mame
P | CO805 1.2 Rename...
{P| COB0S 1.2
| cosos i3 s (s Ed...
P[C0805 1.2 Sort Column Delete
P | CO805 1.2 X
FlCoeas i3 Move Column Right
| cosos 1.2mm "Capacitor/G| B Copy Tags
P| Co805 1.2mm | Capacitor/G: Copy

The columns are initially sorted aphabetically looking from left to right but the order can be modified
to be user definable. Again, using the context menu, use the M ove Column Right option. You aso
have the ability to Show and Hide Columns and to control their visibility using Column Visib
button.

As well as entering values directly, you can aso Copy and Paste val ues between cells (or ranges of
cells) in the grid or from an external source such as an Excel spreadsheet. Ranges can be copied and
pasted using the buttons or by using standard Windows commands, Ctrl-C, Ctrl-V for Copy and
Paste respectively.

Use the Revert button if you have accidentally modified the wrong cells but don't want to cancel the
whole dialog. Pressing Revert will return the selected cells to their original values, leaving other cells
untouched. This button will only be enabled if one or more of the selected cells have been modified.

Viewing the Design

With the fast redraw properties of Pulsonix and the bitmap graphics image used there are a number of
methods of moving around the design and zooming in and out. You can use Menu commands,
Shortcut keys, the World View, and the Mouse Wheel button (if available) to achieve the same
results.

As discussed previously, the World View can be used to quickly locate known items or areas within
the design. In normal design practice, the Zoom options will be required more often than not to get
into detail of the design rather than into new locations of the design.

For this discussion we have concentrated on the primary objectives; zooming in and out quickly on
the design using the most accessible methods.

Mouse wheel button

The mouse wheel button has been described in the previous section but briefly to reiterate, roll the
mouse wheel forwards to Zoom In, and roll it backwards to Zoom Out. Click the mouse wheel button
down once to pan once, and click the mouse wheel down and keep pressed for acontinuous panning
of the design.
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The Zoom and Pan shortcuts

To zoom in and out using the default shortcut keys press <Z> for Zoom In At Cursor and <U> for
Zoom Out At Cursor. These keys will zoom in and out respectively to the current cursor position.

To zoom to the design extents (Zoom Extents), including the board outline and components (and
also including any other design information such as page border etc.) use the <A> key.

To Frame into a design area use the <F> key, click and drag an area around the items required.

The Pan function is available on the <P> key or the middle mouse wheel button. The screen will pan
and centre to the current cursor position, and keep panning if the <P> key remains pressed

View selection allows you to select an item(s) and view just these in the design window without
having to accurately frame the window around them.

You also have the View Board and View Actual Size options. View Board is similar to View All but
it allows you to frameinto just the board outline area regardless of any other design items outside
these extents, for example a page border would not be included in the view unless inside the board
outling! There is no shortcut key assigned by default to this option. View Actual Size will enable you
to visualise your PCB designs at ascae of 1:1 if this option is selected. You may need to caibrate
your screen before using this. Do this from the Options dialog, Display page and Calibrate Actual
Screen Width. Details about performing this can be found in the online help.

View All can be used to view all of the design, this includes dl drawing borders and text outside the
actual board outline. Useful for viewing everything in a Schematic design as well.

Scroll Bars

As part of the Pulsonix framework, scroll bars are also available for panning around the design. By
clicking the small right or left facing arrows on the scroll bars you can pan the design in that
direction. You can aso drag the small button in the middle of the scroll bars to pan the design.

< Scroll bars
/
£ >

@ High speed design L Eval:Frocessing JE\iral:l:l:lnm:clzl:lrs @ RoutingDemol T X

The Scroll Bars can be switched off to make more design space available by toggling the Scroll Bars
option from the View menu.
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Design Item Selection

Select Mode

There are anumber of ways that items in Pulsonix can be picked and selected.

Select
Single select . / /_\_.
Cirl-select Clrl-zelect

Ctrl-select (modify) Selact \
.\
Shiﬂ-s\eled \
The diagram above shows the different modes of selection. The lighter grey shows the selected
segment.

—

Shift-select again

Shift-select (extend)
Ctrl-shift select

Single Select

A single click of the mouse will make a single selection of any item. By selecting another item, the
first selected item will be deselected. Note that the item may be part of alarger entity, e.g. asingle
segment of atrack. If you wish to have more than one item selected use the extended select option
(see below). Once a selection has been made, a process or option can be performed onit.

Mouse Drag

A single click of the mouse followed by a move of the mouse but keeping the mouse button pressed
down will enable a'drag' to be performed. This is often referred to as click and drag. In Pulsonix, this
will perform a M ove on an item, or with nothing under the cursor or within the picking tolerance, will
perform aframe selection.

If the Ctrl key is pressed before drag, the item being moved will also beduplicated, in this instance a
new copy of the item will then be moved.

Control (Ctrl) Select

Using the Control (Ctrl) key while making a selection will modify the selected status of the current
item. This means multiple items can be selected whether they are associated with items aready
selected or not. Using the Ctrl key will toggle the item to be selected or deselected.

Extended (Shift) Select

Use Shift select to increment the selection to the whole entity. This could be the complete net on any
single page in Schematics, or the complete connection/track for all visible tracks on the net in PCB, or
Component if a pad has been sdected. By keeping the Shift key pressed and selecting the item again,
the selection is further increased. This can be shown on atrack that spans more than one device. The
complete 'net’ for the track would be selected.

Some examples worthy of note for extended (shift) selection are; for any completely selected cutout
using Shift will select the whole shape, and for a completely selected copper shape associated with a
template using Shift will select all copper shapes on the template.
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Ctrl-Shift Select

The Ctrl and Shift keys together add to the selection and increase the selection to the complete item.
Y ou might use this if attempting to select two track paths for tracks on different nets.

Path Select

An option on the context menu in select mode allows you to select al segments in a shape or atrack
path between two selected points. If the selected points are in the middle of segments, they are split.

| Select >| Frame Select
Edit 4 Palygon Select
% Cross Probe |f§ Select Path
* o
Select All visible Chrl+a
é? Move *Ié
Select all
% | Type Coordinate... = [g el
Auko Select
4% Type Offset... Shift+= F
Changs Angls To 5 i@ Reverse Layver Order Al+P
EE Rokate By 90 R () Set Coordinate Crigin
% Fotate One Step alk+r | (2 Set Relative Origin Shift+
i0 Mirror il .
o 'ﬁ Select Previous
Lock
& Lod ‘E‘ Seleck Mext M
Change Style... 3
Change Testpaint... X Deselect Al
et 3
Components!Symbols 3

The path select mode can also be accessed by simply dragging along the line or track segment
(provided you have this mode enabled in the Options dialog on Select page under Drag).

The process for inserting segments is to drag along a segment which selects part of the segment, and
then drag the selected segment to creste a‘ top hat’ shape as shown below.

— |

) —— )

If you wish to select more of the shape, then simply drag further along the shape. Once the drag has
been initiated and the shape segment picked up, the mouse movement will mimic the shape of the
segment without having to follow it accurately.

If you don't want to drag to select the path, the Select Path option can aso be used from the context
menu.
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Possible usage
Uses of this could include:

e Dragging segments in atrack or line shape to insert a‘ top hat’
e Unrouting atrack between two points

e Necking between two points (using the Select Path command followed by <S> Style to change
the segment thickness)

e Changes layer between two points
Frame and Polygon Select

Frame and Polygon Select are used to make selections based on areas drawn using the mouse. The
difference between the two modes is that Frame Select alows you to draw arectangular frame
around items, whereas Polygon Select alows you to draw any shape to make the selection.

During Frame/Polygon Select you can aso use the shift key to select extended items.

Frame Select is used by clicking and dragging the mouse around the objects required within the area.
This is the default mode but if you wish to use Polygon Select, right click in free space and pick the
Polygon Select option from the context menu.

Both Frame Select and Polygon Select modes will act on individual track segments to facilitate
segment picking. These operate with the check box in Options, Select page, Select if Completely

Framed set to on or off.

Line Select

With nothing selected in the design, right click and the new Line Select selection mechanism will be
available, if something is already selected it will be on the Select sub folder. Use this to define a
straight line to select only items that cross that line.

Enable Select Mask
@ Frame Select
|[} Line Select
& Polygon Select
[ select Path
*[} Select All Visible Ctri+A

" Select All
Auto Select
Reverse Layer Order Alt+P

Paste Ctri+v

Iy G i w
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Once sdlected from the menu, draw the line The sdlection will then be made:
across the items you wish to select.

Like Frame Select, keep the Ctrl key pressed down to dter the selection. Use the Shift key to extend
the selection to whole items.

Line Select is aso available from the context menu in Align mode and L atched operations such as
Move when nothing is initially selected.

Double-click Editing

By using double-click on an item you will automatically enter the edit mode. On Schematic
connections and PCB track items this means the segment selected will be edited so that its path can
be changed. On PCB connections the connection will be converted to acopper track ready to have the
path created. This editing mode can aso be used for all other shape based items or line editing.

For all other design items the Properties dialog for the selected item will automatically be displayed,
allowing you to make edits based on the contents of the dialog.

Auto-select Mode

Pulsonix has an active architecture, with the database capable of extremely fast selection. To utilise
this fast selection, you have an Auto-select mode of operation available. Auto-select allows you to
move the cursor over items within the design and obtain instant selection without clicking the left
mouse first. Clicking the mouse key now performs the '"Edit' function on the selected item.

Cyclic picking

When attempting to select items within a dense area of the design, it is not dways easy to pick the
item required at the first attempt. Under these circumstances Pulsonix has a system of picking that
‘cycles' through items in close proximity to aid the selection. This allows you to make a selection,
then toggle through the design items adjacent to it until you select the item required.

The keys used for the commands Select Next and Select Previous can be user defined but by default
the Next command is set to <N>, the Previous command is not set by default.

Select from popup list

Holding down the Alt key and selecting overlapping items, a context menu will list all items at that
position, allowing you to select a specific item based on its description rather than the item. This is an
alternative to selecting the first item, then pressing the <N> key to get the new selected item within
the picking tolerance.
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Component
Angled, Layer Top, Net Net 4

Track
‘ Track Vert, Layer Top, Net E1

Track Vert, Layer Top, Net E1

D3, Layer <Top Side=

Via 27,9400 45,0850, Layer Span <Through Hole=, Net E1

This feature can be disabled in the Select section of the Options dialog and Select page.

Configurable selection flags

In addition to the ability to select the next and previous items in the design using cyclic picking,
Pulsonix also contains a mechanism for enabling and disabling design items. This mechanism is
located on the Colours didog alongside the Displayed selection.

8" Colours - Attributes

By making a selection in the relevant check box, you can make individual design items selectable or

not.

'Latch' Mode

L

:)’er:h <30 Package> Layer Displayed | felectable | Colour
ec shapes <Autoplace Rules> Sikscreen Top ¥ []
Doc Shapes <Branch Point Name:> Top [ [~
Pads <Component Height: Solder Mask Top [ []
Boards & Areas [W}<Component Name: Paste Mask Top -] ]
Vias <Component Variant Id> Pin Names ] ]
Text <Curmrent \c"ar?ant Description: Inner 2 [] [ w
& Attributes :Ei:-e;ﬂ \u"a;alE) Ground /] &
Highlights :D abase ie \, Power ] ] w
oth <Database Key> Inner 5 ] ]
ers <Diatabase Status= Bottom [~ [
N_Ets ) ) <Database Table> Silkscreen Bottom [~] [
Differential Pairs <Date Solder Mask Bottor] [] [
Signal Paths <Design Authors Paste Mask Bottom| [] []
Sub Nets <Design Comments> Pin Names (Bottom ] ]
<Design File Paths Board ] [
<Design Name: Construction Lines| [ [~
<Design Revision> Documentation [~] [
[A <Desian Subiect>

Latch mode is a mode of operation that allows atool to be pre-selected (latched) and applied to many
items until it is toggled off (unlatched). For example, the Rotate mode can be latched down and
rotations applied to many components in the design in turn.

To exit latch mode, you can either select the option again to unlaich it, or press the <Esc> key on the
keyboard to return to Select mode. Y ou can dso use the Cancel option from the context menu after
right clicking the mouse.

Context menus

The right mouse button can be used extensively throughout Pulsonix to reveal context menus, these
are also known as shortcut menus or pop-up menus. These menus can be accessed during an
operation or by direct selection using a‘ right mouse click’, each menu has a set of relevant
commands in 'context’ for that option.
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Once familiar with the system, you can access the context menus by right clicking on an item rather
than left mouse clicking to select and then right mouse clicking. By right clicking directly, you can
select the item and display the appropriate context menu.

Change Shape Type...

Po-—- Chonn

Select 4
[ Edt o % cut CtrX
% Cross Probe Copy Ctri+C
§ Move Paste Ctrl+v
Enable Nudge BR puplicate CtrD
¥ Type Coordinate... = TR
4% Type Offset... Shift+= | % Delete Delete
& salke 76 Unextended Delete Ctr+Delete
B Lock P Extend Delete Shift+Delete
Change Style... S

The example above shows the contents of atypica context menu, this one from the pin itemin a
Schematic design. Once displayed, the context menu will remain on the screen until an option from it
is selected or the <Esc> key pressed. The menu options are selected using the left or right mouse

button.

The Design Settings Dialog

Design-based options are defined on the Setup menu in Technology and Design Settings dialog.
These are created for and saved with each individual design, they would also be saved to the
Technology.

8" Technology [] - Design Settings — General

(- Design Settings -
- Coordinate System
=)- Defaults

.. Area

- Attribute

. Bitrap

- Block

- Board

- Branch Point

- Component

- Construction Line
. Copper

- Dimension

- Dimension Units
- Doc Shape

- Embedded View
- Error

- Layer

- Mounting Hole

The Options Dialog

Al Text
[ Adjust To Readable Crientation

[ Multi-Line Text Vertical Align
Banming Character:
{when doubled) I:I

System Font
[ Proportional Width Digits
CAM/Plat
[ Transform about design extents
STEF Model Alignment
Snap by:
(®) Centre
() Origin

Use Adjustment Attributes

Attributes

Substitution Char:

{when doubled)
Matching Styles

(®) By Name Only

(Z) By Name And Value
() By Walue Only

Naming Rules

[ Make named styles use naming rules

Pad Exceptions

[ Mimar with Component

Net Optimise

[ Pads/\Vias connect by centre

Spacing Rules:
[] Enable linking of types

Much of the main option customisation is done through the Options dialog on the T ools menu with
some set-up through the Folder s option. These are generally options on the tools themselves, such as
being able to set the editing angle of the lines etc.
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There are subtle differences between the Schematic and PCB Options dialogs but these relate mainly
to the Track/Connection editing functionality and general PCB functionality, such as On-line Design

Rules Checking and Move (because of Component Pushing etc.).

Options General

- Design Backups

- In-Place Names

- Resolve Net Names
- Select
- Synchronisation

Screen Print

[ Miways Prit in Black

Environment Variables

Wault
Switch Vaul Functionality Off

Importing from Other Systems
Show Design Browser
Default to Mo Technology

Allegro Extract File Path

Mutti-Threading
[ Enable Threads
Thread Court

8

Relative Coordinates Undo:
. Display ) ) .

Show relative coordinates in dislogs when used - =
 Edit Shape . g Number Of Levels: (10 5
- Edit Track Defautt Units: Help:
- File Extensions
Find (®) Impesial (O Metric [] Mways On Top

Cursors: Libraries

[ Floating Manager

- Interaction Style: [Standard -

- Macros [ Close Dialog On Edit
- Maove Use Modal Cursors

- Multi-S

PaLrI1 é.:ZcorZemn Snap Cursor to Grid Recent Files on File Menu
. Online DRC [s F entries

{Mote : Needs program restart to take effect)

Dialog Grids:

- Tooltips
.. Track Length Limits Substitute Character: [ Edt n Double-Cick: oy
- Warnings Open as View Cnly

Open Schematic designs view only

Open PCB designs view only

[ Ask at program startup

Spacing Rules:
[ Enable linking of types

Browse...

The tabs are set out so that they are grouped by logical areas of functionality. The General tab
(shown above) is used to set Pulsonix system type information for example.

More detailed information relating to setting up preferences through the Options dialog will be
discussed in each section of the manual relating to particular features.

The Properties Dialog

Each item in the design contains a set of characteristics that can be viewed or edited using the
Properties option. Some items within the design are made up of several parts, each of which is
individually selectable and have its own properties that can be viewed. For example, a Schematic
Component might contain a number of terminals (or pins), some lines that represent the symbol shape
and some text. The terminals will also have their own properties, such as shape and size etc.

In addition to item properties, there are also Design Properties and Document Properties. Design
Properties are used to show design based information, such as Attributes and the Associated Parts.
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Document Properties shows general statistics about the current design being edited, plus you aso
have the I nspector Bar to use.

Design item properties can be viewed by selecting the item and clicking on the Properties option
from the context menu. The example below shows the Properties of an SCM Star Point.

B Properties: Star Point - Star Point O X
Star Point  Star Point Attibutes  Vault

[ Locked

Angle: [Mimored  Scale:

Symbaol: |Star Point (3 Signals) | Change...

Drawn on:| This Page Only

Joing MNets:| GND
A_GND
Dig_GND

You can dso select the item and click the shortcut key <I> (this is the installed default and can be
changed if required).

From the Properties dialog you can view detailed information about the item selected and can aso
use it to make changes, such as the items name, its rotation/mirror status (if relevant), etc. Major item
changes can dso be made, such as a change to the footprint style from DIP to surface mount for
example.

Multi-ltem Properties

The Properties dialog is dso capable of changing multi items of the same type. Only items of a
similar type can show their Properties together. If the selection includes dissimilar items, Properties
will not be available.

The example design over shows the selection of multiple gates of a Part but one of the gates is
rotated. All of the gates belong to the same device (U1) and al have different Positions in both the X
and Y direction. In the design, only one gate has a different X position because it has been rotated, as
shown by the Angle. The 'Y position would bediff erent because they are placed in a line. All other
details are the same.

Ul.d

%
x X =
ULa ULk < Ule

From this dialog you could now make all the gates the same rotation by changing the Angle: to a set
value, and change their Position: inthe Y axis so that they were all aligned vertically with each-other.
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B Properties: Component - Component O X

Componert  Comp Attibutes ~ Vault

A Name: [ Locked
Position: <Different = |:D'rf'ferent> |

Angle: 0.0 ] Mimored Scale: [1.000000

Bat: |489D106X0010CT | | Change..

[] Description: |CAP 4830 16V TANT CASEC

[ Part Famity: |435‘ | Altemate...

[ Footprint: [m] Specify Footprint:
BEAD 0.6mm

[ Symbal: |C polarised? -

] Pin Names Pin Logic Names

Once this was done, the <Different> indicators would show avaue. This would be reflected in the
item changed in the design.

Attributes

Another use of the Properties dialog is for adding attributes to design items. From the Attributes tab
you can assign an atribute name and value, you could add a<Hyperlink> attribute on the Comp
Attributes tab for example.

B Properties: Component - Comp Attributes O X

Component Comp Attributes  Vault

[xHyperink >=http:/www.vishay.com/ Mew...
[«<Part Family>=489
[(Category=Capacitor/Radial Lead/Solid Tant/Case C/RoHS Edit...
[ Mfr=Vishay

[n=106 Delete
[JTol=20%
[v=18v
Value=10uF

Y ou can dso opt to show the attribute on the item by selecting the check box on the left of the
attribute name and value.

Adding Attributes from a file

With the Attribute Properties dialog you can also take an external text file or selected text and
simply drag and drop it onto the atributes page.

The whole text file can be dropped onto the atributes to add new attributes or edit/update existing
values. The format must in attribute=value, such as MFR=Motorola. Partial text values can be cut
and pasted into the attributes page if you prefer not to use the whole text file.
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Chapter 3. General Utilities

Undo/Redo

Pulsonix contains unlimited multi-level Undo and Redo capabilities for use through the product.
Undo can be used to reverse the last operations that have been completed. Undo can be used
sequentially to undo more than one operation. It can dso be a useful and flexible tool to interactively
try different iterations of an operation, manual routing for example.

If you use lots of Undo levels, this will use up your memory. In this case, you should either install
more memory or restrict the number of Undo levels.

Undo and Redo steps are only available back to the maximum number of levels set. Not dl operations
are available to Undo/Redo, alist of unavailable operations is listed in the on-line help under Undo.

The number of Undo levels is set up in the T ools menu under the Options function and General tab.

B Options General O
-~ Design Backups Relative Coordinates Unde:
- Display ) ) -

Show relative coordinates in dialogs when used - =
 Edit Shape . g Mumber Of Levels: (10 =5
- Edit Track Defautt Units: Help:

- File Extensions

Find (®) Imperial O Metric [JAways On Top
I Mames Cursers: Librares

- Interaction Style: |Standard » [ Floating Manager

. Macras ’ e Mo = e Faa

With any Undo level set, say 4, when the fifth Undo step is required it will overwrite the first
operation in the Undo buffer that is then lost. So care needs to be taken if using restricted levels of

Undo.

Using Undo and Redo

Undo and Redo are invoked using the standard Windows shortcut keys <Ctrl-Z> and <Ctrl-Y>
respectively. These have been defined as part of the installed set of default keys but can be changed if
required; these are also available on the Standard toolbar as buttons. Redo is only available once an
Undo has been performed, until then, it remains on the menu but is greyed out as unavailable.

Interactive Operations

Overview

During operational use of Pulsonix there are anumber of interactive operations that allow items to be
moved, rotated, mirrored .and edited. The following sections cover this collective set of features and
describes their use and how to set their mode of use where applicable.

Moving ltems

There are two methods of moving objects in Pulsonix. The first and most widely used is the drag and
drop methodology, for use when an interactive move is required. This is modeless in that it can be
used without a mode selected. The second method is the M ove mode. This can be accessed from the
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Edit toolbar button and from the context menu. It allows you to move items with the mouse button
left up.

By clicking on any item in the design you can use click and drag to move that item. Depending on
how much of the item is selected depends on what is moved. For example, if a segment of ashapeis
selected and dragged, the segment will be 'stretched until released. If the whole shape is selected, the
whole shape will be moved to a new location. Components are a special case for this type of move.
When a Component is selected and regardless of how much of the Component is selected, the whole
Component is moved. The Component is made up of individual entities 'grouped' together to form the
Component library shape, thus is acts as a complete unit when moved.

The dternative methods for moving items are to select the item first and click the M ove button from
the Edit toolbar, or M ove from the context menu. Once in Move subsequent options are the same.

You can dso use Move in Latched mode. This means that Move can be selected from the Edit
toolbar first, and then applied to items within the design. This mode will be retained as long a the
Move button is latched. This option can be unlatched by selecting another option or by selecting the
Select button or by pressing the <Esc> key.

l% When in any move operation, asingle click of the mouse will release the item in its
i current location. During this operation a modal cursor is displayed (this must be
switched on in the Options dialog and General teb).
During any move operation the context menu can be accessad to provide additional options for use,
for example, Rotate, Mirror, Layer, Style etc. The options available depend on the current
gpplication and the item the Move is being applied to.

The context menu example is split in half to show the extensiveness of the optiosn available:

Force Vector

«J¥ Optimise Selected Nets
Show Track Length Limits

Repaosition Cursor Text

Shift=L

Use No Grid Shift=N

Cancel Move Use Tools Grid Shift-W

Finish Here Use Tools Component Grid

Use Dynamic Align
[+] online bac
Z‘ Continuous Online DRC
Z‘ Display Clearance

v Type Coordinate... = Use Tools Track Grid

dy Type Offset.. Use Tools Via Grid

|:|':I Type Rotate... Use Tools Testpoint Grid

0 Mirror

Show Placement Origin
i Show Dynamic Cons Only

Optimisation Mode

Free Angle Adjoining Segs
Preserve Attached Segments

Constrain Orthogonal Segment

Change Angle To 3 Use Track Grid
D-él Rotate By 907 R Z‘ Allow Checking of Multiple ltems Use Warking Grid
2) Rotate One Step Alt-R Bu:hikgde Y| useText Grid
73 Change Rotation Step... Push Direction 4 Use 0.5mm Grid
M Spring Back

Use Via Grid

‘ Use Companent Grid

Use Testpoint Grid
Use Panel PCE Instance Grid

Optimal Position Move Horizontally Display Grids Ctri=G
Optimal Rotation CEra il = Grid step... G
Force Vector Change Grid 3 H Grids... Alt+5

The context menu above shows typicd functionality found when in the Move option. This example is
for the M ove Component option.

When using Move, a Grids selection is available from the context menu, please refer to the next
section headed Grids for more information.

Line segments that are Mitred or Curved can also be moved but will retain their size and make the
adjoining segments each side dynamic. To edit or move a Mitre or Curve you should use the edit
facility. This can aso be accomplished by double-clicking the mouse on the segment to be edited and
then dragging the segment to the required position.
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Mirror

The ends of straight line segments and corners in general on open shapes can be moved by selecting

the end of theline and dragging it.

A small circle appears a the end to indicate that it is the end segment that has been selected. From
this point you can drag the line item to resize it.

Mirror can be used on most items within the design including connections in Schematics. Sometimes
also known as‘ Flip’ but called Mirror in Pulsonix. It is available from the Edit toolbar, using the
shortcut key <M >, and from the context menu when an item is selected or being moved. Mirror is
also available from the context menu within the Item Properties dialog for some items. It is not
available for al selected design items.

Mirror can also be used as part of Move. During the moving of an item Mirror can be selected from
the context menu or from the keyboard using the shortcut key <M >.

Mirror in Schematics

Within Schematics, Mirror will flip a Component or Documentation Symbol using the centre of the
symbols bounding box as the axis point. Text in Schematics cannot be mirrored.

When used with connections, Busses and Shapes within Schematics any dynamic segments can be
mirrored across to their opposite diagonal point. This applies to any two segments but does not apply
to more than two segments or less than two segments.

o

B

Mirror in PCB

When used in the PCB editor, Mirror has three effects. Thefirst will flip the complete Component,
Documentation Symbol and Text to the other side of the design (if the alternative opposite side is
available). When surface mounted components (with surface mounted pads defined on asurface
layer) the pads will also be mirrored to the other side of the design automatically. The second effect
will work on whole design shapes and will mirror the shape on the same layer. The third mode will
work on any two dynamic segments.
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Mirrored Components

Components and Documentation Symbols are mirrored around their Component origin axis to
maintain their position. The diagram below shows how the Component will look after rotation but has

been moved over to the right for clarity.

The axis points would actually be coincident once mirrored.

o]

Where whole shapes are selected, the shape is mirrored about its origin. This would be the pick point
of the shape; in the example below the axis would be the edge of the shape.

Axiz point

zshape Mirrared to Here

Where two dynamic segments are being edited, the segments are flipped to their opposite diagonal
corner. The two examples below show the track segments flipping, and the dynamic segments of a

shape flipping.

0

0O
% v

Mirror can also be used in Latched mode. To use this, select the Mirror button from the Edit toolbar,
and apply it to each item selected. You must deselect the option by selecting the Select button or
another option before Mirror is unlatched.

o000

% When used in this mode, a modal cursor is available.
LI

Rotating Items

Rotate can be used on most items within the design. It is available from the Edit toolbar, using the
<R> key as a shortcut, and from the context menu when an item is selected or being moved. Rotate is
also available from the I tem Properties dialog for some items either single or multiple items of the
same type (it is not available for all design item types). This is particularly useful if a number of
components are selected for rotation to the same angle, for example.



Chapter 3 — General Utilities 63

When moving an item, Rotate can be selected from the context menu or from the keyboard using the
shortcut key <R>. For ease of use, rotation steps can be taken from the context menu as steps of 90
degrees, or Rotate One Step to rotate by 90 degrees.

Rotate can also be used in Latched mode. To use this, desdlect everything and select the Rotate
button from the Edit toolbar, and apply it to each item in turn. You must exit the option by selecting
the Select button or another option.

% When used in this mode, amodal cursor is available

Rotation steps can be defined down to 1/100,000th of adegree, this level of precision allows accurate
rotation of items when using polar/radial grids. The precision and rotation unit type of Degrees or
Radians can be defined from the Settings menu under Angle Units on the Units dialog.

Technology [] - Units - Units

+- 3pacing Rules Length Units:

- Styles _—

o Loyers O Imperial:  thov

+ MNets (® Metric: mm ~
+- Rules - DFM/DFT

+- Rules - High Speed Precision: E 5

+- Outputs

+ Naming Trailing Zeros

- Colours Rounding Indicator (+/-)
4. Grids

- Units ]

L Units Angle Units:

+ Variants ® Degrees O Radians
+- Design Settings Precision: |1 S

- Parameters

Trailing Zeros
Rounding Indicator (+/-)

When using the rotation modes, the setup of the angle for which items use is defined from the Tools
menu and Options. From the Interaction tab use Rotation Step to set the default rotation step of
any item rotated.

Rotation steps are always defined in an anti-clockwise (Counter-clockwise) direction but can be
defined in a clockwise direction by specifying the rotation step as a -ve (negative) number, e.g. -90
(degrees). Normally the rotation steps would be specified as a positive number. Rotation steps can be
specified in any value or part value by typing in the number required.

Type Rotate Option

During M ove, you dso have an additional rotation option; Type Rotate. Use this to rotate the current
selection about a particular point and by a specified amount by typing the values into a dialog.
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Type Rotate 4
R otate About:
®o|9825 (O Typed Coordinates Cancel
v [12074e (®) Selection Origin
() Selection Certre
Giet From Clipboard () Coordinate Systern Origin
Fielative Origin
Folar Grid Origin
Rotate By Angle: [ Palar Fiotate
Diztance From Origin:

If used in M ove, the rotation is applied to the selection in its original position unless you are adding
thefirst item. This way you can position subsequent items rotated relative to the first item added.
Also if you are using Duplicate or Apply Layout Pattern, you do not have to use Cancel M ove
before rotating into position.

Check the Polar Rotate box to change the two edit boxes to accept an Angle and M agnitude to
define the position of the selected items using absolute polar coordinates applied about the rotation
point. The selected items will be rotated about the rotation point until their origin is at the required
angle and then moved towards or away from the origin until the distance from the selection origin to
the rotation point is equal to the required magnitude.

fingle: 330 /| Polar Rotate

M agnitude: 0o

Polar Rotate

Check this box to change the two edit boxes to accept an Angle and M agnitude to define the position
of the selected items using absolute polar coordinates applied about the rotation point. The selected
items will be rotated about the rotation point until their origin is at the required angle and then moved
towards or away from the origin until the distance from the selection origin to the rotation point is
equal to the required magnitude.

Rotate About

This mode is available from the Select Mode context menu. For a selected component(s), you can
choose to Rotate About from the context menu and then set the rotation origin.

Chaiigs Angie 0 3
08 Rotate By 90 R
& Rotate One Step Alt+HR.

L% Rakate About

E—? Change Rotation Step...

00 miror M
Eb Al

This option alows you to enter the Rotate One Step latch mode operation and lets you pick the point
that you want to rotate the selection about.
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Special cases of rotation
Bus Terminals in Schematics

The 45 degree line emerging from abus is called a bus terminal. This terminal can be setup to be
always Up or Down (and Left or Right on horizontal busses) but can never be mixed to show both Up
and Down (and Left/Right).

U
Do

Bus terminal

Bus Connections Left Right

The default direction of the bus terminals is set in the Design Settings dialog, under the Defaults tab.
Once adirection has been set and a bus terminal used on the design, the direction can be changed
using the Rotate option.

Readable Text in Schematics

When any item containing text or any text item is rotated in Schematics, the design can be setup so
that the text is always readable from the bottom or the right of the design page. If thetext itemis
rotated further than an angle that makes it unreadable it is austomatically rotated back to areadable
state. This mode is set in the Design Settings dialog under General and is defined setting the check
box under All Text to Adjust To Readable Orientation.

This mode can be overridden for individual terminals by using the Ignore Readable Orientation
check box in the Text Properties didog. This is dso available in the Attribute Properties dialog.
Selecting this switch disables the effect of the Adj ust To Readable Orientation switch (from Design
Settings— General dialog) for that specific text instance..

Properties: Component Attribute - Attribute O X

Attribute  Text Style Componert Nets on Fing  Comp Attributes  Variants  Vault

Name: | <Component Name:

|
Usage: | Part |
Value: [C14 |

Position: [ Locked
Angle: (] Mimored

Layer: |Silkscreen Top v

Text Ali nt:
éo%meBoﬂom Lt | [ lanore Readable Orientation

0]0]0]
Olele]
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Grouped Items

Grouped items (from Frame Select, Polygon Select or M ultiple select) can be rotated and done
using the centre point of the group as the rotation origin from where they are rotated. The bounding
box of the group includes any text or origin items as well as any visible or invisible items.

Design Repoasitioning

The complete design may need to be rotated during the design process. This can easily achieved by
right clicking the mouse in an area of free space on the design. From the context menu select
Reposition Design. You can apply an X and Y positional shift or just apply a Rotation to the design.

Reposition Design X
ShitBy: ¥ [10000 | v [0 |
Rotate By:

Cancel

Design Rotation for Output

The complete design may require arotation from Landscape to Portrait for example, to dlow it to
fit on a paper page when plotted. This is not required if this is the sole requirement, the CAM/Plot
output feature enables you to plot the design rotated by the simple use of a Rotate Design check box
on the Plot Pasitioning tab.

Lock and Unlock

Lock is used to fix design items so that they cannot be moved or edited. Unlock is used to 'release’ or
Unlock the item following a Lock operation.

It is available from the Utilities menu and the Edit toolbar and from the context menu when an item is
selected. Lock is aso available from the Item Properties dialog.

Unlock is only available on the context menu after a Lock has been performed on an item.

Lock and Unlock can also be used in Latched mode. To use this, deselect all and select the Lock
button from the Edit toolbar, and apply it to each item then selected. You must exit the option by
selecting the Select button or another option.

Modé cursors are available to show the current Lock or Unlock mode being used.

When attempting to perform an operation on an item that is locked you are presented with awarning
dialog from where to make a choice of which action to make:

Operation on Locked ltems X

Before performing the operation, what do pou want to do
with the locked items?

Deselect them  [DO MOT perform operation on them,
() Unlock them [Perform operation on them |

(®) Keep locked [Perfarm operation on them]

Perform Qperation Cancel

This dialog tells you that the item is Locked but aso gives you the option of continuing with the
operation requested.
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By selecting one of the radio buttons, then the Perform Oper ation button, the operation can still be
performed but is completely under your control. You also have the opportunity to not perform the
operation, if selected by mistake for example.

Special cases
Importing from other systems

When importing adesign from another system using one of the built-in import filters, someitems are
automatically locked in place when the design is viewed in Pulsonix. These items can be subsequently
unlocked using the Unlock option.

Track Locking in the Auto Router

While using the integrated auto router option, you have the ability to lock tracks that already exist in
the design and to lock new tracks added by the auto router. Once subsequently using the interactive
features of Pulsonix you can lock or unlock any tracks as normal anyway.

Track Locking

Tracks can be locked in the PCB design editor. This maybe particularly useful when using 'fanout’
type track patterns on a Component as it will prevent accidental removal of tracks and vias from the
design. If using the auto router, you also have additional control over their removal, see above.

Locking Vias

Vias can be locked in isolation to the tracks that they are connected with. This will prevent their
removal even if connected to tracks that become deleted. You may have critically positioned the via
in the design and allocated it as a Testland. Even with no tracks connected to it, the via still remains
connected &s attached to the net.

Cut, Copy, Paste and Duplicate

Cut and Copy are used to copy and remove items from the design and place in the clipboard, or to
take a direct copy of an item and place into the clipboard respectively.

Paste is used after items have been placed in the clipboard (from using Cut or Copy) and adds them
to the design.

Duplicate is used to copy item(s) and paste them into the design. This option is used for direct copies
within the same design.

All of these options can be used on al design items. They are available from the Standard toolbar, as
shortcut keys from the keyboard, and from the context menu when an item is selected. These options
are also available as menu options from the Edit menu.

As adefault, the shortcut keys in Pulsonix include the standard Windows shortcuts where available
but these can be redefined if required.

Cut <Ctrl-X>
Copy <Ctrl-C>
Paste <Ctrl-v>

Duplicate <Ctrl-D> and <Ctrl-drag>

As an additional shortcut method to using Duplicate, you can also use <Ctrl-drag> while making a
selection. Instead of moving an item, the item is duplicated and the new copy moved ready for release
in its new position.

These options are available on selected groups of items regardless of whether they are similar or not.
The same rules apply to groups as for individual items or multiple selected items.
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Special cases and rules of operation

Paste/Duplicate into the same design will cause the Resolve Net Names dialog to be displayed if the
selection contains any named nets. If the selection only contains default net names the net names are
automatically incremented to the next available in the sequence while being added to the design. Any
Component names within the selection are also automatically incremented to the next availablein the
sequence.

Resolve Met Names *

Nets in thiz list already appear in the target design.
'Check! those that should merge with the coresponding

net in the target design. Any unchecked' nets wil be
renamed according to the ‘Rename' zettings.

+5v[Pawer] FS Rename
233; (®) Auto-lncrement
ADD3 () Prefix

ADD4 )
ADDS O Suffix
14006

HSE1

HsE2

LCI_EMAR

LocaL

RSO In 1 v

Select lbems

Cancel

Al Named: | [a- | Check

MNane With Class | hd | Uncheck

Schematics

If the selection contains a portion of a multi-gated device, the unselected gates or unused gates are
added to the Component Bin for later use.

While Duplicate cannot be used across pages, Paste can be used. Selected items can be Cut and
Copied to other sheets if required.

Items being Pasted onto apage are checked across dl pages, this applies to both net names and
Component Names.

Safe Mode

When using Pulsonix in Safe M ode, Paste and Duplicate will not be available if it means adding in
new design items that change the netlist in any way. In this mode, if you wish to change or add design
items you must return to the Schematic design and make the changes there before using Synchronise
Design to make the changes to the PCB.

Copy to another shape type
When using Copy/Paste on ashape, the shape can be added to the design as a new shape type.

Before pasting the new shape into the design you put Pulsonix into the I nsert Shape mode required
for the new shape. For example, if copying a Board Outline shape to a Template shape, you should
copy the board first, then select Insert Template shape and Paste. The new copied shape will be
exactly the same shape as the board outline but will be atemplate ready to be placed. While in this
Insert state, more options are available from the right mouse button, change layer, change style etc.
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Grouping Iltems

Items in the design can be grouped together for moving etc. When more than one item is selected, the
Group option appears on the context menu. Selecting this option causes al the items to be added to a
new group. If the items are deselected and then one of the items is selected, al other members of the
group become selected.

iy
ff—

Edit »

Cross Probe

Move

Type Coordinate. .. =
Type Offset, ., Shift+=
Rotate By 90 R
Rotate One Step Ale+R

o 7 % = Uh &%

|
O

Mirrar il
Lock

Wﬁﬁ Ungroup

Shiow Met Name Tight Group
E Mame Group...

L=

Group

!
1]

Components/Symbols 3

If the group is to be named, select the group and select Name Group from the context menu.

Group Name X
Mame: |E5T0'~JI3"I Vl
Context: |F'EIB Design Only v|

Tight Group

Groups can be named and the group and name passed through from Schematics to PCB designs. If the
group is to be translated to PCB, it must be named. Named Groups can be managed using the
Technology dialog and Group Names tab.

Name | Tignt Context
v | Groupl o All Designs
Processor (Support) v All Designs

Groups are created as Tight groups, that is al members of the group act as one. If you want to make
changes to individual members of the group, change the group type to Loose. This can be done by
selecting the group and unchecking Tight Group on the context menu. Any group member when
selected will then act individually. To change back to atight group, select any member of the group
and check Tight Group.
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Create PCB Group from SCM Block
You can dso mark aBlock instance (using Block Properties) to Create aPCB Group when in PCB.

The equivalent group is added to the PCB and Synchr onise Design will keep them in-line. The group
has the same name as the Block, with an optional prefix (which is defined in the PCB, see below).

B Properties: Block Instance - Block

Block  Block Ports  Block Instance  Block Instance Attributes  Vautt

Name: |B1 |

[ Block: |Block‘l | Change...
Generated Block

[ Description:

Can be Multiphy

nstanced Create PCE Group <:|

[ Locked Instance
Locked To Vault
Block Name Prefix

If required, set the Block Name Prefix for usein the PCB from the Technology dialog, Design
Settings — Gener al/Defaults and Defaults button. Choose Block and type the name of the Block
Group Name Prefix:

When viewed as a group, the name will look like this, showing the Prefix first, followed by the Block
Name.

Group Name X

Mame: |Block_Blockl "

Caontext: | PCE Degign Only

Tight Group Add To Group

Deleting ltems

Delete can be used on dmost any item within the design. Some exceptions are detailed in the Special
cases section below. Delete can be used to delete selected item(s), or can be used in latched mode
where the Delete option is selected first and applied to items within the design. When used in latched
mode you can only exit it by selecting the Select button on the toolbar or another option.

The Delete option can be selected by pressing the Del key on the keyboard or by using the Delete
option from the Edit menu, or the Delete button on the Edit toolbar, or the Del option on the context
menu.

There is no confirmation to delete, however the Undo option can be used to recover any deleted
design information, provided an option hasn't been used that removes the Undo levels from memory.

% When Delete is used in Latch mode, amoda cursor is available.

There are 3 different ways to perform ddete that are relevant to a Component or Symbol, for dl other
item types the Delete function deletes the item.
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e Unextended Deete will just delete the Symbol leaving any connections ‘dangling’ . This canbe
used in conjunction with the Auto Weld option in Schematics.

e Extend Delete will delete the Symbol and connections leading from the pins on the Symbol back
to the pin or junction at the other end of the connection.

e Thedefault Delete option behaves as Unextended Delete in Schematics and as Extend Delete in
PCB.

e Thedefault hot key for Delete is the Delete key, with Shift-Delete for Extend Delete and Ctrl-
Delete for Unextended Delete.

Special cases

Schematics

Deleting one gate of a multi-gate Component will not remove the Component completely if one of the
other gates on the Component are still being used. It will put the deleted gate into the Component Bin
as unused. This will happen to each until the last gate of the same Component is removed from the
design, at this point all the gates for that Component will be removed from the Component Bin as
well.
Ul-a
SNFIACTREN Component Bin X

1
5 Ut-d
z SMF4ACTAD M
Ui-h >e12_
%
=
R Y- UL - SNT4ACTOON
g
1o |

In the previous example shown, if four gates of U1, a 7400 device, are placed on the design, when
Ul-b is deleted it appears in the Component bin and Ul-a.c,d remain on the design. Finally, with just
one gate left on the design, U1-c say, al other gates gppear in the Component bin. When Ul-c is
removed, U1 with all four of its gates are removed from the Component Bin and the design.

Safe Mode

In either of the design editors you can run Pulsonix in Safe Mode (by selecting this mode in the
Options, General dialog). This means that the netlist (nets and components) cannot be changed in
that design editor without using the Synchronise Design option. In this mode, you cannot delete any
nets or components that would affect the netlist. Safe mode can be chosen for either the Schematic or
PCB designs deoending on which one you select as your ‘ master’ design.

Deleting Nets/Tracks

To remove a connection in PCB you must use the Remove From Net option from the context menu
once the connection has been selected.

Delete on tracks in PCB has the same effect as Unroute Track. If you want to remove the track and
the connection, you must use Remove From Net.
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Add Corner

Edit Segment
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Disconnect Con End

ﬂ’% Highlight Selection
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These modes can be used when the PCB is in context, i.e. either as the master when used with
aschematic design or when being created without a schematic design.

Inserting Text

Single line and multi-line text can be added to both Schematic and PCB designs as well as library
items. The style of the text used in the design is defined in the T echnology dialog under the Text
Styles teb.

From the T echnology dialog, you can also change the Text Stylesto aso include TrueType fonts as
an alternative to the standard ‘stick’ system stroke font.

Name | Height Line Width Font Underlined
Attributes 50.0 5.0 =System Stroke Font=
%" | Component N: 50.0 5.0 =System Stroke Font=
Errors 50.0 Arial
Header 80.0 Arial
%" | Logic Names | 50.0 5.0 =System Stroke Font=
% | Net Mames 50.0 5.0 =System Stroke Font=
Normal 50.0 5.0 =System Stroke Font=
" | Pin Mames 50.0 5.0 =System Stroke Font=
Table 150.0 10.0 =System Stroke Font=
Table Small : 100.0 10.0 =System Stroke Font=
Title 200.0 200 =System Stroke Font=

The Name is used to define the name of the text style when used in the design. The Width and Line
Width define the character width used and the thickness of each line 'stroke’ making up the character.
The Font can be defined from the list of installed Windows system fonts and the default <System
Stroke Font>.

As with all styles to be used in the design it is more efficient to define arange of relevant styles for
Text. This will allow you to categorise the text being added into types, this makes it easier to change
all of atype by changing the style values.

You can dso define text styles as you insert text into the design using Change Style from the context
menu or pressing <S> on the keyboard.
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Text Style X

Mame: | Component M ames -

Teut Size [+] in Points

Height: [7.00 =

Faont
| Trebuchet M5 ~

[ Underline

From this dialog you can change the Size and Line Width of the text but will also alow you to
change the style name or use the default style name presented to you. The style presented in this
dialog is added to the Technology dialog under Text Styles. It can only be edited in the Technology
dialog and not in the Text Styles dialog where it was initially added. This festure is in addition to
adding the text style to the Technology dialog directly as part of setting up your design styles. If using
this method you should aso remember to alter the Technology file if the styles are required in other
designs. Technology files are described in the next chapter.

In PCB, text that is added to electrical layers becomes an electrical 'block’ that is checked during
Design Rules Checking and On-line DRC, and that has its own (Text) Spacing Rules defined in the
Technology dialog. Text on non-électrical layers is not checked.

The text origin can be changed for each individual text string. Multiple text items can aso be selected
and their origins changed together. Once the text items have been selected they can be changed
through the Item Properties dialog on the context menu. You can select from one of nine Text
Alignment positions. By default, the text position is always Bottom L eft, this can be changed
through this dialog or by using the Change Text Alignment option from the context menu.

B Properties: Text - Text O X

Text  Text Style Variants

Pulsonix
BW iss2

Angle: [ Mirored: [ Locked

Layer: | Silkscreen Top e |

Text Alignment: ] own Calour
OO Bottom Left

OQ0O
®00 —4

You can dso change the colour of text items to contain their own colour rather than that defined in
the Coloursdialog for Text. Care should be taken when changing the colour of particular text items
so that there isn't confusion identifying the layer for example that the item appears on.

The text font can be changed from the Properties dialog also using the Text Style tab.
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Vertical Text Alignment for Multi-line Text

The switch, Multi-Line Text Vertical Align, in Design Settings, General, under All Text enables
you to set the text position for multi-line text in the vertical axis. When enabled, this causes all multi-
linetext to vertical align using the height of dl the text, not just the first line alignment. Thisis a
design setting, so it will change the vertical alignment of al multi-line text in your design so care
must be taken if gpplying this after already having added multi-line text, especially on electrical

layers.
All Text Attributes
[J Adjust To Readable Crisntation Substitution Char: {when -
doubled) -
I Multi-Line Text Verical Alignl
Barming Character: l:l Matching Styles
{when doubled) @ By Name Only

(O By Name And Value
System Fort
() By Value Only

M P o1 WAELL Fu_as

The two images below show the effect of this switch. To clarify where the alignment is taken from,
horizontal and vertical construction lines have been added to the text to show the movement.

The left image is before switch is activated (and as current product), the right-hand image is after:

Multiline text
spread across
different lines
Multiline text showing alignment
spread across
different lines
showing alignment

Special cases
Pulsonix has the ability to cope with special text cases where formatting or style is required.

Forceto Upper Case

By defining what text items should be forced to upper case (capitals) it then makes no difference
whether upper or lower casetext is typed in, the text will always appears in upper case. This is
particularly useful for Component names that by default are forced to upper case.

This feature is setup in the Technology, Design Settings dialog on the Naming tab. It is
recommended that unless experienced with Pulsonix you should not change it.
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Force To Upper Case Mame Options

Component Names Case Sensttive Fin Names

[ Gate Names [ Numeric Gate Mames

[ Net Names Fill-in Gaps In Number Ranges
[ Part Names [ Case Sensttive Dril Size Idents
[ Pin Names

[ Test Point Names

Mame Ranges
Default Met Names Range Start: D

Mame Stem: Range End: EI
Number Width: Range Separator: l:l

ltem Separator: I:I

Example: U1,U[3-6]

Pin Names

Component to Pin

Name Separator: I:I
Case sensitive pin names

The case sensitivity of pin names can be changed using this check box. This means that both upper
and lower case text can be typed in and the system recognises the differences, even if only subtle. For
example, differences such as A1 and al would be understood, even if you typed one of them in by
mistake!

This mode is set in the Design Settings dialog under Naming and is defined by setting the check box
under Pin Names to Case Sensitive.

Adjust text to readable orientation

When any item containing text or any text item is rotated in Schematics, the design can be setup so
that the text is always readable from the bottom or the right of the design page. If thetext itemis
rotated further than an angle that makes it unreadable it is automatically rotated back to areadable
state. This mode is set in the Design Settings dialog under General and is defined setting the check
box under All Text to Adjust To Readable Orientation.

P To add text to the design
1. Fromthelnsert menu, select Insert Text.

2. Typetherequired text into the window.
The text can be upper and lower case. Multi-line text can be added by pressing <Enter> at the
appropriate places. You can use dl the normal text editing facilities including copy and paste.
The full ISO-Latin-1 character set is supported. You can aso add barred text using the barring

character.
The Insert Text dialog changes slightly between the Schematic and PCB design editors shown
below:
Insert Text * Insert Tesxt *
lssue 2 Pulzonix
Crrawvan by B B izs2

Layer: | Silkscreen Top -

Cace

Diravary o | I
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3. Oncompletion click OK and position the text.
The schematics Insert Text dialog has adrop down list for drawing on All Pages At This Level.
Whenever text common to dl pages is edited, the changes are reflected through all the pages.
This is useful within company sheet outlines that are the same on al pages for example.

The text will be positioned at the end of your cursor.

Use the mouse to position the text at the exact location required. During positioning, you can use
the options on the right hand mouse context menu to: Mirror or Rotate the text and also change
the text Style and Font. The justification of the text string can be dtered by selecting the text and
using Properties.

6. To reeasethetext, click the mouse. This will release the current text item and put you back into
the Insert Text didog. Click the <Esc> key to exit this mode.

Barred text

Barred text can be added to the design (both Schematic and PCB). There are two steps to enable
barred text. Thefirst is for the definition of the barring character in the Design Settings dialog under

the General/Defaults tab.
All Text Attributes
[ Adjust To Readable Orentation Substitution Char:
[ Mutti-Line Text Vertical Align fwhen doubled)
. . Matching Styles
E?ITenngd%:abE?}er. |:| (@ By Ngam:rl Only

(C) By Name And Value

System Fort
¥ (O By Value Only
[ Proportional Width Digits
Naming Rules
CAM/Plot

[ Make named styles use naming rules
[ Transform about design extents

Pad Exceptions

STEP Maodel Alignment
[ Mimar with Companent

Snap by:
(@) Centre Net Optimise
() Origin [ Pads/Vias connect by centre
Use Adjustment Aftributes Spacing Rules:

[ Enable linking of types

This by default is the underscore (___) character but can be changed if required. The second is to
enclose the text string to be barred with the barring character. This must be doubled both before and
after the text string to enable the bar.

B Properties: Text - Text O X

Text  Text Style Variants

4

|_Bamed Text__ Not Bamed

In this example the words Barred Text are enclosed with double underscore characters and the
words Not Barred are not enclosed to highlight the diff erences. There is a subtle space character
between the ending barring character and the word ‘ Not .

When added to the design, the text appears like this:

Barred Text Not Barred
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Mitring and Filleting Corners

Mitres (45 degree corners) and Fillets (curved corners) can be added to any shapeor line item,
including PCB tracks and Schematic connections. Mitres can only be added to 90 degree corners on
straight segment lines. There are a number of methods for adding and editing them.

Mitres and Curves behave in the same way and are added and edited the same way.

Basic adding of Mitres

Starting with two orthogonal segments creating a 90 degree corner, a Mitre can be added by double
clicking on the corner. You must double click rather than picking and dragging, the pick drag function
will move the corner and segments rather than adding the Mitre. You can also select the Mitre Corner
option from the context menu if the corner is selected.

%} When Mitre Corner is used, amodal cursor is displayed.
L

The Mitre is a free moving 45 degree corner on the two orthogona segments. This snaps to the grid
points of the Track Grid or the Working Grid/Free Grid that has been previously used when inserting
the shape or track. By using agrid rather than leaving the Mitre to be afree grid segment you can
ensure that the corners of the Mitre are always on-grid.

to create the
mitre here or here
Drag this corner
to here

Onceinserted, Mitres can be easily edited by double-clicking on the 45 degree segment. To remove a
Mitre, double click on it and drag it out to make it a 90 degree corner again.

For connections in Schematics you cannot used the double-click method, you must first select the
corner and then use the Mitre option from the context menu. If you use the double-click method of
editing an existing corner, the program will attempt to insert a connection and will therefore add a
junction point to the corner instead of editing it.

Fixed Mitre sizes

If you require all Mitres to be the same size, you can set the size and set the snap to this size when the
Mitre is inserted.

The Mitre size is set in the Options dialog under either the Edit Track/Connection tab or the
Interaction tab, depending on what type of item you are editing. Editing options of shape items
except for Tracks and Connections (in Schematics only) are set through the Interaction tab. The
example tab shown below is for Interaction but the information presented is the same for the Track
and Connection tabs as well.

B Options - Edit Track O %
Design Backups - .
Display Segment Mode: |Ang|ed (45) w | [ Apply Seg Mode to Tail
Edit Shape Orthogonal Mitre [ Auto Comer

E4 Size: Type: (@ Mitre () Fillet Tolerance:

File Extensions
Find
General Show "Can Finish' and "Has Loop’ Markers Remove Loops

In-Place Mames Show Legal Completion Path Auto Share Tracks
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The setting used is Under the Orthogonal Mitre and Size. The Size will be set in the current Design
Units. Orthogonal Mitre does not need to be selected for this option to operate. This is only selected if
you require Auto Mitring to be operational, see below for description.

To use this default Mitre size you must first be editing the corner. With the corner selected you can
right mouse click and select Mitre Corner from the context menu, this will edit the corner. If you
immediately right mouse click again you can select Default Mitre Size from the context menu. This
will snap the Mitre to the default size set in the Options dialog.

From the context menu, you also have the option to Fillet corner to make it curved.
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Overview

Chapter 4. Setting Up The Design

There are anumber of features and options that alow you to setup adesign prior to starting the actual
design work itself. Some of these features are highly desirable, like setting up the working Units for
example or the interval of the security copies of the design. Others are not essential but pref erences,
like changing the colours to your own choice. With the diff erences between the Schematics and PCB
design editors, only the major differences are discussed and some of the more important subtleties.

Using Folders and Files

Folders

When saving files you can set up the save locations. The Folder s option on the Setup menu contains
the path setup information in one dialog of all the options that use paths. By default, during Setup the
paths within the Folders dialog are set to the standard Pulsonix install ation paths, these can be
changed by editing the relevant one.

Folders - General O X
4 General Startup Folder
CAM/Plot On inthis folder - |C-\Users\MAINDocument Browse
Colour Files ways start in this folder : | C:\Users"\MAIN Documents Browse
Design Backups (C) Remember last folder used when Application closes
Design Reports (®) As defined by Operating System for example. in the Program Shortcut)
Format Files
Libraries a | Fald
Library Reports =aeners] roler
Macros C:\Users"MAIN'Documents | E Browse ... i
Profile Files
Schematic Blocks Used for any files that have no folder defined forthem. For exa!nplz_e. )
. reports that are not design based. Leave blank to use the application’s
Scripts cumert folder.
STEP Models
Technology Files
Folder Options

[1Show Folder For Each File {in the file dropdown lists)

The General tab defines the folder the program starts up in and the location that is used for ‘ general’
non-design based reports, such as the shortcut keys report.

The choices on this tab alow you to decide the best start-up location, it may be that you wish to start
on aserver or alocd disk but in aworking folder of a particular project etc. There are three options
that give you a selection of start-up choices. This tab will allow you to choose a folder that could
contain your current working design. When Saved, the design will overwritten at its current location.
If Save As is used, the current folder of the design will be displayed and you can change this as
required.

The Design Backups tab is used for specifying the location of Design Security Copy files, Backup
Copies of the design and Restore Points.



80 Chapter 4 — Setting Up The Design

Folders - Design Backups O X

General
CAM/Plaot
Colour Files

Folder For Design Security Copies:

|This Folder below design file: ~ |

g Design Backups
Design Reports
Format Files

|C:"-.Users"-\MAIN"-.D0c:umerds"-.Designs"-JobEE"-.Bac:kups | Browse...

Libraries ) )
Library Reports Folder For Design Backup Copies:
M